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[ Usage and Safety Precautions

)

Safety Precautions

In this operation manual, symbols are used to
highlight warnings and cautions that you must
read to prevent accidents. The meanings of
these symbols are as follows.

Something that could cause

- serious injury or death.
Warning

Something that could cause injury

or damage to the equipment.
Caution

Other symbols used

o An action that is mandatory.

® An action that is prohibited.

| AWarning

Operation using an AC adapter
0 Never use any AC adapter other than a
ZO0OM AD-19.

Operation with external DC power supply

@ Use a 9V-16V external DC power supply.

0 Carefully study the warning indications of
the external DC power supply before use.

Operation with batteries
Use 8 commercially-available 1.5V AA bat-
teries (alkaline dry cell batteries, nickel
metal hydride batteries or lithium dry cell
batteries).

0 Carefully study the warning indications of
the batteries before use.
Always keep the battery cover closed
during use.

Alterations

® Do not open the case or modify the prod-
uct.

| A\ Caution

Product handling
Do not drop, bump or apply excessive
force to the unit.
Be careful not to allow foreign objects or
liquids to enter the unit.

Operating environment

© Do not use in extremely high or low tem-
peratures.
Do not use near heaters, stoves and other
heat sources.
Do not use in very high humidity or where
it could be splashed by water.
Do not use in places with frequent vibra-
tions.
Do not use in places with much dust or
sand.

AC adapter handling
When disconnecting the power plug from
an outlet, always pull on the plug itself.

0 Disconnect the power plug from the outlet
when the unit will not be used for
extended periods and whenever there is
lightning.

Battery handling

a Install batteries with the correct +/— orien-
tations.

“ Use the specified batteries. Do not use
new and old batteries together. Do not use
batteries of different brands or types
together.

“ Remove the batteries when the unit will
not be used for extended periods.
If a leak occurs, thoroughly wipe the bat-
tery case and battery terminals to remove
the leaked fluid.

Danger of explosion if battery is incorrectly
replaced. Replace only with the same or
equivalent type.

A warning that batteries (battery pack or
batteries installed) shall not be exposed to
excessive heat such as sunshine, fire or
the like.

Mic handling

a Always turn the power switch OFF before
connecting a mic. Do not apply unneces-
sary force when connecting a mic.
Attach the protective cap when no mic is
connected for extended periods.

Connection cables and input/output jacks

0 Always turn the power OFF for all equip-
ment before connecting any cables.
Always disconnect all connection cables
and the AC adapter before moving the unit.

Volume
Do not use at a loud volume for extended
periods.

Usage Precautions

Interference with other electrical equipment
In consideration of safety, the = BB has been
designed to minimize its emission of electro-
magnetic waves and to suppress interference
from external electromagnetic waves. How-
ever, equipment that is very susceptible to
interference or that emits powerful electro-
magnetic waves could result in interference if
placed nearby. If this occurs, place the 8
and the other device farther apart.

With any type of electronic device that uses
digital control, including the B8, clectio
magnetic interference could cause malfunc-
tion, corrupt or destroy data and result in other
unexpected trouble. Always use caution.

Cleaning

Use a soft cloth to clean the exterior of the unit
if it becomes dirty. If necessary, use a damp
cloth that has been wrung out well to wipe it.
Never use abrasive cleansers, wax or solvents
such as alcohol, benzene or paint thinner.

Breakdown and malfunction

If the unit becomes broken or malfunctions,
immediately disconnect the AC adapter or DC
power supply, turn the power off and discon-
nect other cables. Contact the store where you
bought the unit or ZOOM service center with
the following information:  product model,
serial number and specific symptoms of break-

down or malfunction, along with your name,
address and telephone number.

Copyrights

o Windows® and Windows® 7 are trademarks
or registered trademarks of Microsoft® Corpo-
ration.

© Macintosh, Mac OS and iPad are trademarks
or registered trademarks of Apple Inc.

o The SD, SDHC and SDXC logos are trade-
marks. MPEG Layer-3 audio compression tech-
nology is licensed from Fraunhofer IIS and Sis-
vel S.p.A.

o Bluetooth and the Bluetooth logo are regis-
tered trademarks of Bluetooth SIG, Inc. and are
used under license by ZOOM CORPORATION.
o Other product names, registered trademarks
and company names in this document are the
property of their respective companies.

Note: All trademarks and registered trade-
marks in this document are for identifi-
cation purposes only and are not
intended to infringe on the copyrights of
their respective owners.

Recording from copyrighted sources, including
CDs, records, tapes, live performances, video
works and broadcasts, without permission of
the copyright holder for any purpose other than
personal use is prohibited by law.

ZOOM CORPORATION will not assume any
responsibility related to infringements of copy-
rights.

Note about the Auto Power Off function

The power will automatically turn off if unused
for 10 hours. If you want the power to instead
remain on, see "Disabling the Automatic Power
Saving function" on P20 and turn the function
off.



[ Introduction

Thank you very much for purchasing a ZOOM I~ 8 Multitrack Field
Recorder.The I B8 has the following features:

¢ 8 analog input channels with super high-quality preamps
The 8 lockable XLR/TRS combo jacks provide high-quality analog
inputs with EIN of =127 dBu or less, +75 dB maximum input gain and
support for +4 dB input.

¢ PCM recording at up to 192kHz/24-bit resolution

¢ Recording of up to 10 tracks simultaneously
Inputs 1-8 and a stereo mix (left and right) can be recorded at the
same time (8 tracks when the sampling rate is 192 kHz).

¢ Dual channel recording of separate files at lower levels
simultaneously with ordinary recording (Inputs 1-4)

Using dual channel recording at a lower input level, you can create
backup recordings to use when unexpected loud noise causes regu-
lar recordings to distort, for example.

* Newly redesigned limiters for overload protection

With 10 dB of headroom, this limiter prevents distortion even more
than ordinary ones. The threshold can also be set to keep the signal
below that level.

*Time code with pinpoint accuracy

The IF B utilizes a high-precision oscillator that generates time-
code with accuracy of 0.2ppm, ensuring rock-solid stability when
syncing audio and video.

e Outputs include a stereo headphone jack with a powerful
100mW amp as well as MAIN OUT 1/2 and SUB OUT 1/2
jacks

This allows you to send the audio signal to a video camera or other
device while monitoring with headphones.

¢ Built-in digital mixer with flexible signal routing
Prefader and postfader signals from inputs 1-8 can be freely routed
to any outputs.

* Phantom power (+24V/+48V) can be supplied
This can be turned on/off for each input separately.

*Three possible power sources —batteries, an AC adapter and
an external DC power supply

In addition to AA batteries and an AC adapter, a 9-16V external DC
power supply can also be used.

¢ Double SDXC card slots

Simultaneous recording on 2 SD cards is possible, and support for
SDXC cards up to 512 GB enables long-duration recording. In addi-
tion, the I B3 can be used as a card reader by connecting to a
computer using USB.

¢ USB audio interface capabilities with up to 8 ins and 4 outs
The IF B3 can be used not only as a 2-in/2-out audio interface, but
also as an 8-in/4-out audio interface (driver required for Windows).

¢ Other useful features

Other convenient functions include a built-in slate mic for voice
memos and a variable frequency slate tone generator to confirm lev-
els.There are also input and output delays and pre-recording of up to
6 seconds.

¢ ZOOM mic capsules can be connected
Use any ZOOM mic capsule instead of inputs 1/2.

Please read this manual carefully to fully understand the functions of
the I B8 so that you can make the most of it for many years.

After reading this manual, please keep it with the warranty in a safe
place.

uonPNpoIIU|
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[ Names of parts

Front
Select Slate Track Track Track
Display encoder switch indicator key knob
- LED level
oD meter
| LED level meter
| @ PFL key Green Orange Red
Jn@ Slate mic 48 30 -18 -12 -6
| T (dBFS)
|8 S— -
MENU  Headphone Search Stop Search Play/pause Record POWER
key volume  backward key forward key key switch
key key
Back

DC IN connector

[arate e

Timecode IN/OUT
connectors

MIC IN
connector

Battery slot



Left side
EXT DCIN USB SD card
connector port slots

Lock release
button

==K

PR === Jﬂ@
o =—

Inputs 1-4

EXTDCIN

4+ 1=

2:NC

3:NC (\\/)

DC 9-16V

HIROSE 4-pin

D

Inputs 1-8

S = o

1: GND
2: HOT
3: COLD

SUB OUT 172
jack jack

ImEm|

Right side

Headphone

MAIN OUT 1/2
jacks

(

©
SUB OUT 1/2

@;—m

‘. 7~ \\ MAIN ouT
) @)
Je ~ (PUSH) 7 . (PUSH)
~ K\

TRS

TIP: HOT

RING: COLD

SLEEVE: GND

Inputs 5-8

MAIN OUT

1 3

@ ...

2 2:HOT
3:COLD

TA3
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[ Connecting mics/other devices to Inputs 1-8

The I B3 can record a total of 10 tracks simultaneously: 8 individual tracks with signals coming from Inputs 1-8 and a stereo

mix of these inputs on left and right tracks.

You can connect mics and the outputs of line-level devices such as keyboards, mixers, or instruments with active electronics
to Inputs 1-8 and record them to tracks 1-8. Alternatively, Inputs 1 and 2 can instead receive input from a ZOOM mic capsule

connected to the I B3 MIC IN connector.

Connecting mics

Connect dynamic and condenser mics with XLR plugs to
Inputs 1-8.

Phantom power (+24V/+48V) can be supplied to condenser
mics. (— P90)

(XLR cable) (XLR cable)

NOTE
When disconnecting a mic, gently pull on the XLR plug while simul-

taneously pushing the connector lock release button.

Connecting line level equipment

Connect the TRS plugs of keyboards and mixers directly to
Inputs 1-8.
Direct input of passive guitars and basses is not supported.

Connect these instruments through a mixer or effects device.
s

(

©8
© 8
°
8
°
8
°
8
°
8
°
8
°
8

00000
00000
00000 | |®
00000 | @
00000 | @
00000 | [®
00000 | [®
00000 | [®
[e]e]e)

[] «m=0 [ 00000

[ =0
[ =0
0 <=0
0o
0<—=—0
[ =0
[ =0
0 <=0

(TRS cable) (TRS cable)



)

Connecting mic capsules

A ZOOM mic capsule can be connected to the MIC IN connec-
tor on the back of the I B3.

e The mic capsule input is assigned to tracks 1/2.

e When a mic capsule is connected, Inputs 1/2 cannot be used.

Connecting and disconnecting mic capsules

1 = Remove the protective caps from the 8 and the

mic capsule or extension cable.

2 = While pressing the side buttons on the mic capsule or

extension cable, connect it to the main unit, inserting

-

it completely.

mp ) <=

3 = To disconnect the mic capsule or extension cable, pull
it away from the main unit while simultaneously

pressing the buttons on its sides.

* Do not use too much force when disconnecting. Doing so could
damage the mic capsule, extension cable or main unit.
e Reattach the protective cap when a mic capsule is not connected.

Stereo input

By enabling the stereo link for tracks 1/2, 3/4, 5/6 or 7/8, the
corresponding Inputs (1/2, 3/4, 5/6 or 7/8) can be handled as a
stereo pair. (— P27)

When linked, Input 1, 3, 5 or 7 becomes the left channel and
Input 2, 4, 6 or 8 becomes the right channel.

8- sinduj 01 s8d1A8p J8Y10/solw Bundsuuo)
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[ Connecting mics/other devices to Inputs 1-8 (continued)

Connection examples

The IF B3 allows you to record in a variety of situations, such as the following.

While filming

e Input 1: gun mic for main subject sound (XLR connection)

e Inputs 2-5: wireless lavalier mics for performers (TRS
connections)

¢ Inputs 6-7: mics for ambient sound (XLR connections)

Wireless lavalier mics

Gun mic

Lavalier receivers

»)) » )) )) ))

Ambient
mics

Concert recording

¢ Inputs 1-4: mics for stage performance (XLR connections)
e Inputs 5-6: line-level PA mixer outputs (TRS connections)
¢ Inputs 7-8: mics for audience sound (XLR connections)

P
@@
H
@6
H

8

H

8

M

8

N

8

M

8

N

H

(o ooRONONO)

00000000 o
Q0000000 0]
00000000 00
00000000 00
OO0OO0O0OO0OO0OO0O0O OO0
Vocal mic, etc. I } ‘liii\ Sessssss s
* TR
LA AL S AL

PA mixer

-ﬁ.u'u’nn!-
Audience mics
jmEm] i \
EE > MR () | oot /

] OpiEl oot /

b O ooy | Be—




( LCD display )

Home Screen Power type and remaining power
H Status icon Recording/playback timecode DC: AC adapter @ Full
= Mixer Py EXT: external DC
D Stopped |:I] Paused Frame rate power supply
INT: internal timecode enabled AA: batteries
. Recording |} Playing EXT: external input timecode enabled

Counter
(playback/elapsed recording time)

| - 3
[#] 0 E
Phantom power status

Lit: enabled 6 I -

énal = LIM :
Unlit: disabled Fader ; 0

Pan
Recording/playback take name
Press[=_Jwhen stopped to show the
name of the next track to be recorded.

L/R tracks

Track number

Red: input enabled

Green: playback track enabled |_
Grey: input disabled

Limiter status
Grey: disabled
Red: enabled
Yellow: functioning

,_
=

Stereo-linked
inputs

+

Level meters
Clip indicators

Limiter indicators
Yellow: limiter functioning

WAV 48.000
MP3 220kbps

Aejdsip 01

Playback card Recording/playback  Recording/playback tracks
Green: used for playback file format and Red: recording tracks When recording: remaining recordable time
Grey: no card sampling rate Green: playback tracks When playing: remaining playback time
(by card) Grey: disabled tracks (by card)
(by card)
HINT

e Stereo-linked tracks are shown together, for example, "7/8".
e When the Home Screen is not displayed, press and hold to
return to the Home Screen.
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[ LCD display (continued)

= L evel meters
Recording/playback

Status icon Counter Frame rate timecode
Power type and

remaining power

000 ' ' 00 Hﬁﬁ§9§§05 ' Clip indicators
1

Limiter
indicators
Tracks 1-8
L/R tracks Level
meters
MAIN OUT 1/2,
SUB OUT 1/2
tracks
-12 -G
Recording/playback BBl : wav 48.000 Sem30
take name 502 : MP3 320kbrs 013053

Playback  Recording/playback When recording: remaining recordable time

. E INT 23.97D card file format and When playing: remaining playback time
B 000:00:00 53:{1 7406 = - oy oy 9 play

sampling rate

o MR- v
o |

USB1-4

o I o ———
Ud_!!l|_|!!||III!!!II"|_|!|J""""I_I!IIII"""D SUB OUT 1/2, USB1-4) or level meter display (Views 1-4 can be set

Empty Folder BB way 42000 003h43 — P.163) shown on the LCD.




Character input screen

Edit L

DC

Text box Pro ject001] Numoerofcharectrs ot o [ Pro ject001] 10/40
[1]2]3]4]5]e]7]8]9]0]
(alBfc]DJE[FIGIH]T]I]

0880686006000
>Walolcldlelflelnlili

covwozra| K L [MINJOIPIQIR]S]T]
(ulvIw]x]Ivy[z] -] pe
|a_bc| Enter

Instructions EW/FF<—/—> MENU . Cancel

] ec
Edit ]

DC

Pro ject001| 10740

8806000080
8000000006

Automatic (Project) I (Scene) I Del

input keys .
|_ABC |

REW/FF:<-/ > MENU : Cancel

¢ The following characters can be used in project names:
(space)!#%$'()+,-0123456789;=@ ABCDEFGHIJKLMNOPQRSTU
VWXYZ[]*_"abcdefghijkimnopqrstuvwxyz{}~

press (ETTD (k] (plafr]s]t

(ulvlw]x]ylz] -] De
K Enter

REW/FF4-/ > MENU : Cancel

Press

= Editing operations
Move cursor in box: and

)
Character selection: Turn the @ to move horizontally and
turn it while pressing @ to move verti-
cally

Confirm character:  Press @
Complete editing:  Move cursor to “Enter” and press @

Cancel editing: Press

HINT

* Press + to delete the previous character.

® Press + to move the cursor to “Enter”

Aejdsip 01
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[ LCD display (continued)

= Automatic input keys
(Date): Automatically inputs the date. Example: 150210
(Time): Automatically inputs the time. Example: 180950
(Project): Automatically inputs “Project***” in the field.
(Scene): Automatically inputs the scene name.

Aedsip @01
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[ Supplying power

Using AA batteries

1 = Turn the power off and then loosen the screw in the

battery cover to open it.

2 = Remove the battery case from the battery slot.

3 = Open the battery case cover.

4. Install the batteries.

5 = Replace the battery case cover.

6. Load the battery case.

Load the case so that the side with the protruding rail is up.

7. Close the battery cover and tighten the screw.

NOTE

e Be careful because the battery case could become loose unex-
pectedly if the cover screw is not tightened firmly.

e Use only one type of batteries (alkaline, NiMH or lithium) at a
time.

e After loading batteries, set "Power Source" to the correct type of
battery. (— P.22)

e If the remaining battery power indicator turns red, turn the power
off immediately and install new batteries.

J1amod BuiAjddng
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[ Supplying power (continued)

Using an AC adapter

1 = Connect the dedicated AC adapter to the DC IN

connector.

2 = Plug the dedicated AC adapter into an outlet.

Using an external DC power supply

1 = Connect the external DC power supply equipment to

the EXT DC IN connector.

Connect a 9-16V direct-current power supply.

!

2 = [If there is an adapter, plug the adapter into an outlet.

* When connecting an external DC power supply, be sure to make

the power supply settings. (— P.22)




[ Loading an SD card

1 = Turn the power off and then open the SD card slot

cover.

2 = Insert the SD card into the SD CARD 1 or 2 slot.

To eject an SD card:
Push the card further into the slot until it clicks and then
pull it out.

NOTE

e Always turn the power off before inserting or removing an SD
card. Inserting or removing a card while the power is on could
result in data loss.

e When inserting an SD card, be sure to insert the correct end with
the top side up as shown.

e If an SD card is not loaded, recording and playback will not be

possible.

e To format an SD card, see P. 176.

pieo Qs ue Bujpeo
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[Turning the power on and off

Turning the power on

POWER
1. Pressand hold (] briefly.

POWER

The (__J) LED will light.

000000 H

NOTE

® The first time you turn the power on after purchase, you must
set the date/time (— P. 19).You can also change this setting later.

e If “No Card!” appears on the display, confirm that an SD card is
inserted properly.

e |f“Card Protected!” appears on the display, the SD card write-pro-
tection is enabled. Slide the lock switch on the SD card to disable
write-protection.

e |If “Invalid Card!” appears on the display, the card is not format-
ted correctly. Format the card or use a different card.To format an
SD card, see P. 176.

Turning the power off

POWER
1. Pressand hold (] briefly.

Keep pressing it until the ZOOM logo appears on the LCD.

The F B8 will automatically turn off if
it is unused for 10 hours.

To keep the power on continuously until powered off, see "Dis-
abling the Automatic Power Saving function" on P21 and set Auto
Power OFF to Off.




( Setting the date and time (Date/Time (RTC)) )

The date and time set on the FF B8 are used when recording files, for example.
You can also set the date format (order of year, month and day).

P Continue to one of the following procedures.

1 = Press . Setting the date and time ......ccccceeeeeeciie e, P19

Setting the date format.......cccccveiieeiciiie e, P20
=)
= . -
2 = Use @ to select SYSTEM, - \ Setting the date and time
REC »
=)
and press @ PLAY ’ 4 Date/Time (RTC) )
TIMECODE ’ - Use to seIeCt Set Date Format yy/mm/dd
ST 3 .
MENU: Return Date/Time, and press .
3 @ , SYSTEM MENU : Return
= Use to select Date/Time
Power Source »
Auto Power OFf On
(RTC ) ’ and press @ ) Home Timecode Display Size Small 5 - Change the setting. Set Date/Time

Level Meter »

LED Brightness 100 = Changing settings C0157 04 01 (WED)
MENU : Return

Year Month Day

13 00 : 00

) MENU : Cancel
Turn @

The first time you turn the l= B on after purchasing it, you Select item to change: Press @

must set the date/time.

Move cursor or change value:

((014) awi]/e1eQ) BWI pUE B)Ep BY} Bumes
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( Setting the date and time (Date/Time (RTC)) continued) )

Setting the date format

=
6- Use @ to select Enter, Set Date/Time

— —
Year Month Day 4 @ Date/Time (RTC) =
d @ 2015 04 01 (WED) - Use to SeIeCt Date Date Format yy/mm/dd
and press .

13 : 00 : 00 @ Set Date/Time >
e | Format, and press .
This completes setting the date

and time. MENU : Cancel

MENU : Return

=)
5 = Use @ to select the Date Format

mm/dd/yy
dd/mm/yy
format, and press .
MENU : Return
Setting value Explanation
mm/dd/yy Month, day, year order
dd/mm/yy Day, month, year order
yy/mm/dd Year, month, day order




[ Disabling the Automatic Power Saving function (Auto Power Off) ]

The power will automatically turn off if the I~ 8B is unused for 10 hours.
If you want the power to stay on continuously until powered off, disable the Automatic Power Saving function.

1 = Press .

=\
Use @ to select SYSTEM,

and press @

2.

P

Use @ to select Auto Power

0ff and press @

—x
4. Use @ to select 0ff,

On
and press .

c

QUTPUT
REC

PLAY
TIMECODE
SLATE

SYSTEM 4

MENU : Return

e

SYSTEM
Date/Time (RTC)
Power Source
Auto Power Off On
Home Timecode Display Size Small
Level Meter »
LED Brightness 100

MENU : Return

»
»

=

Auto Power Off

MENU : Return

21
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[Setting the power supply used (Power Source)

Set the external DC power supply shutdown voltage, nominal voltage and type of batteries so that the remaining power supply

charge can be shown accurately.

On this menu page, you can also check the voltage of each power supply and the remaining battery capacity.

1 = Press .

=)
2. Use( ) toselect SYSTEN, =

OuUTPUT

»
REC »
and press . PLAY » |
TIMECODE >
>

SLATE

SYSTEM

MENU : Return

=)

SYSTEM (|
3. Use @ to select Power ¥

Date/Time (RTC) 4
Source, and press @

Auto Power OFf On

Home Timecode Display Size Small
Level Meter »
LED Brightness 100

MENU : Return

P Continue to one of the following procedures.

Setting the external DC power supply (Ext DC) shutdown

voltage . ...t P22
Setting DC power supply (Ext DC) nominal voltage. .. .. P23
Setting the AA battery type (IntAA). ................. P23

Setting the external DC power supply (Ext DC) shut-
down voltage

When an external DC power supply is being used, if the voltage
drops below the value set here, the = B3 will automatically stop
recording and turn off.

If AA batteries (Int AA) are installed, however, the power supply will
switch to Int AA and operation will continue.

=
4- Use @ to select Shutdown

Voltage, and press .

Power Source
DCIN - Wi
ExtDC 0]
Shutdown Voltage 130V

Nominal Voltage 148V
IntAa ]
Battery Type Alkaline

MENU : Return

HINT

e The shutdown voltage is the voltage when the external DC power
supply runs out and can no longer supply power.

e See the manual for the external DC power supply for the shut-
down voltage value.

Shutdown Voltage

=
5- Use @ to select the
voltage, and press .

130V 3

MENU : Return



Setting DC power supply (Ext DC) nominal voltage Setting the AA battery type (Int AA)
=) P =y
4. use @ to select Nominal o @mﬂs‘m = 4. use @ to select Battery e @P"wersme
ExtDC ] ExtDC 0]
oltage, andpress (o). [T Ty, and press (). oo

Intan ]
Battery Type Alkaline

MENU : Return

Intas |
Battery Type Alkaline

MENU : Return

ey —
Nominal Volt: o=
5 = Use @ to select the omnel Yolage e 5 Battery T
= Use to select the type, >
« flkaline
voltage, and press gy = Ni-MH
9% P . ' and press . Lithium

MENU : Return

MENU : Return

HINT
e The nominal voltage is the voltage of the external DC power sup- ¢ When multiple power supplies are connected, they will be used
ply under normal conditions. This value should be indicated on in the following order of precedence.
the outside of the external DC power supply. 1. Dedicated AC adapter (DC IN)
e This can be set from 12.0 to 15.0V in 0.2V intervals. 2. External DC power supply (Ext DC)
3. AA batteries in unit (Int AA)
e The voltages of each power supply are shown on the display.
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[ Recording process

Recording with the - B3 follows the process shown below.
The data created for each recording occurrence is called a "take".

°
(4

Turn power

on (— P.18) recording

Prepare before

Play back
and check
(— P.51)

Check take
information
(— P.63)

Record

Hooee o
[ L]
r ° o
e ° N
e Connect mics, instruments, : ® Press @to start and . Pressto start playback * Check and edit
audiovisual equipment and . @to stop recording. and@or [+ Jtostopit. metadata.
other devices to Inputs 1-8. o | *»You can also set marks. * Marks, for example, can also
(—P.8) i o | ePress[ e Jtostart be set.
e Connect a mic capsule to the e recording a new track.
MIC IN connector. (— P.9) °
H
[
§ . J
[
[
[
[
°
e N
1. Set the SD card and file format 2. Select the recording tracks 3. Make recording settings 4. Adjust the input levels
for recording. (— P.25) (— P.27) * Make other settings, including for the (— P.28)
* Set the recording file format for each ¢ Use track keys to select. following functions: .U ! . .
: se to adjust each input.
SD card separately. The indicators for selected tracks light - dual channel recording (— P.33) ) J. P
red and you will be able to monitor - pre recording (— P.35) e The side mic level can also be
input sounds. - high pass filter (— P.82) adjusted when using a mid-side mic
e Press two track keys simultaneously - limiter (— P.83) capsule.
to link them as a stereo track.
\ J




[ Enabling recording on SD cards and setting file formats

The recording file format can be set independently for SD CARD slots 1 and 2.

HINT

* Recording the same content to two cards is possible by using
the same settings for both card slots. This function can be used
to create a backup in case the sound skips on one card, for
example.

* You can also record tracks 1-8 unmixed on one SD card while
recording all tracks mixed together as MP3 or WAV data with left
and right tracks.

1 = Press .

—x
2 =« Use @ to select REC, MR

FINDER

META DATA (for Next Take)
and press . INPUT

QUTPUT
REC

PLAY

)
=
3. Use @ to select o

Rec to SD2 Tr1-8 (Poly>
Sample Rate 48kHz
WAV Bit Depth 24
MP3 Bit Rate 320kbps
Dual Channel Rec »

MENU : Return

Rec to SD1 orRec to SD2,

and press @

type, and press @

Rec to SD1 L

bC

=)
4 . None
= Use to select the file

Trackl-8 (Mono/StereoWAV)

Trackl-8 + L/R (Poly WAV)
Trackl-8 + L/R (Mono/Stereo WAVY
L/R (Stereo WAV

Setting value Tracks recorded Explanation
None - Nothing is recorded on the SD card.
Track1-8 A single (multitrack) file is created that
(Poly WAV) Selected tracks contains audio for multiple tracks.
Track1-8 1-8 A single mono file is created for
(M /St WAV) each mono track and a single stereo
ono/stereo file is created for each stereo track.
Track1-8 + LIR A single (multitrack) file is created that
(Poly WAV) All selected contains audio for multiple tracks.
Track1-8 + LR tracks A single mono file is created for
M /St WAV) each mono track and a single stereo
ono/stereo file is created for each stereo track.
L/R (Stereo WAV) UR tracks A stereo file is created based on the
L/R (Stereo MP3) mix created by the internal mixer.
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[ Enabling recording on SD cards and setting file formats (continued)

NOTE

L]

When recording with a Mono/Stereo WAV setting, the audio files
are saved in a take folder that is created. (— P.38)

When recording to 2 SD cards simultaneously, files will be saved
in take folders with the same name on both cards. Folders will be
created automatically if they do not already exist.

If recording should stop on one SD card because, for example, it
runs out of space, recording will continue on the other SD card.
At such times, do not remove the card that has stopped recording
from the slot. Doing so could damage the card or data.




[Selecting inputs and adjusting levels

)

You can select which of Inputs 1-8 to use. Inputs will be recorded on tracks with the same numbers. For example, Input 1 will

be recorded on track 1 and Input 2 will be recorded on track 2.

Selecting inputs

1 = Make the track indicator light by pressing the track

key for the number of the input to record.

1 I][I.l][ll]l] l]l]l]ﬂl]ll

-:é:-\.._ i:i m
ﬂﬂﬂl]l]l]ﬂ ‘[—I[l[l[lﬂﬂll mﬂﬂﬂﬂﬂﬂ ‘n I]I]I]UUI'.I

PFL)’
The background color of the track number on the LCD also
changes at this time.

L Track number .
Track indicator Explanation
background color
Lit red Red The input is enabled.
Unlit Gray The input is disabled.

NOTE

The signals from the inputs selected this way will also be sent to
the L/R tracks.

Linking inputs as a stereo pair

1 = While pressing track key 1, press track key 2.

000000 000000 000000 () 000000
M B
(S—r=y ..‘m -."Vm 4

ﬂ [l[llJlJlJl] ‘n UDUUU[I ﬂ lJlJl]U[l[l m [l,ﬂ’gliﬂ

Tracks 1 and 2 will be linked as a stereo track (stereo link).
Repeat the same procedure to disable the stereo link.

HINT

e The 3/4, 5/6 and 7/8 track pairs can also be stereo-linked in the
same way.
* When a mic capsule that allows independent L and R input selec-

tion is connected, stereo-linking can also be enabled and dis-

abled for those tracks.

s|eas| Bunsnlpe pue sinduj Buios|ag
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[Selecting inputs and adjusting levels (continued)

Adjusting input levels

ﬂﬂﬂﬂﬂﬂﬂ|ﬁﬂﬂﬂﬂﬂﬂ ﬂﬂﬂﬂﬂuu 8 U‘U,g]:,u m

When a mic capsule is connected, for Inputs 1/2 is disabled.

Use the level control on the mic capgulg to adjust its input volume.

HINT
* Inputs connected with XLR plugs can be set from +10 to +75 dB,

and inputs connected with TRS plugs can be set from -10 to +55
dB. Tracks with the USB set as the input source can be set from
-35 to +30 dB.

e If the sound distorts even when you lower the input level, try
changing mic positions and adjusting the output levels of con-
nected devices.

e Using the limiter (— P83)

e Using the high pass filter (— P.82)




[ Recording

ER

A 4 (PR A
@Ilﬂlllllﬂﬂ @Ilﬂlllllﬂﬂ @llﬂu.llﬂﬂ B IIIID.IHII)
DD DED
A RN (A (Fr LA

[EIE][EJ?&DED

fr—-s]

IEHAE SEEA OES

CEOF
g

L —1

1 = Press .

This starts recording.

HINT

If the timecode function is enabled, recording will start from frame
00 (00 or 02 when using drop frame) and files will always end
exactly on a second.This makes synchronization easy when editing
later.

2 = Press to start a new take when recording.

This will end the current take and start a new take while
continuing to record without interruption.

Pressing during recording is only possible after recording for
at least a second.

3. Press to pause.

NOTE

* When pausing, pausing will occur at a whole second increment.
e When recording is paused, a mark is added at that point.
Press to resume recording.

e A maximum of 99 marks can be added to a take.

HINT

e During playback, you can press and to jump to points
where marks have been added.
* You can also add marks without pausing. (— P. 169)

4. Press to stop.
Nore

e |f the maximum file size is exceeded during recording (— P.36),
recording will continue in a new take with a number that is one
higher. No gap in sound will occur between the two takes when
this happens.

e When recording on 2 SD cards simultaneously, if recording
should stop on one because it runs out of space, recording will
continue on the other SD card without interruption.

HINT

e Files are automatically saved at regular intervals during record-
ing. Even if the power is interrupted or another unexpected prob-
lem occurs during recording, an affected file can be restored to
normal by playing it with the = &3.

* Press and hold when the HOME screen is open to check the

name that will be given to the next take recorded.

Buipioday
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[Setting the sampling rate (Sample Rate)

You can set the sampling rate used to record files.

1.

2.

Press .

—=x
Use @ to select REC,

and press @

—=x
Use @ to select Sample

Rate, and press @

=
Use @ to select the

sampling rate, and

press @

MENU

FINDER

META DATA (for Next Take)
INPUT

QUTPUT

REC

PLAY

bC
Rec to SD1 Tr1-8 (Poly)
Rec to SD2 Tr1-8 (Poly)
WAV Bit Depth p
MP3 Bit Rate 320kbps
Dual Channel Rec 4

MENU : Return

Sample Rate
44.1kHz
47.952kHz
47.952kHz (F)

v 48kHz
48,048kHz
48.048kHz (F)

MENU : Return

Setting value

Explanation

44.1kHz, 48kHz,
88.2kHz, 96kHz, 192kHz

These are standard sampling rates.

Select this when recording video at 23.976 frames

47.952kHz per second if you want to edit at 24 frames per
second later.
Select this when recording video at 24 frames per
48.048kHz second if you want to edit at NTSC 29.97 or 23.98

HD later.

47.952kHz (F),
48.048kHz (F)

These function the same as the two above, but the
<FILE_SAMPLE_RATE> sampling rate metadata
will be recorded as 48kHz.

This enables playback and editing with devices
and software that do not support 47.952kHz and
48.048kHz WAV files. Playback, however, will occur
at the £0.1% speed at which the file was recorded.

can be selected.

* When the recording file format is MP3, only 44.1kHz and 48kHz

e When 192 kHz is selected, L/R tracks will not be recorded. The
Input Delay and Output Delay are also disabled. Moreover,
Auto Mix, Ambisonic Mode, and Input Limiter > On/Off > On
(Advanced) cannot be set.

¢ Audio Interface with Rec cannot be used when values other than
44.1 kHz or 48 kHz are selected.




( Setting WAV file bit depth (WAV Bit Depth)

You can set the bit depth of WAV files.

=
1 = Press . 4- Use @ to select the bit

depth, and press @

—x
2. Use @ to select REC, MEN

FINDER

WAV Bit Depth

MENU : Return

META DATA (for Next Take)
and press . INPUT

QUTPUT
o HINT

PLAY This can be set to 16-bit or 24-bit.

—x
3- Use @ to select WAV Bit

Rec to SDL Tr1-8 (Poly)

Rec to SD2 Tr1-8 (Poly)
Sample Rate 48kHz
Depth' and press @ WAV Bit Depth 24
MP3 Bit Rate 320kbps
Dual Channel Rec »

MENU : Return

(yrdaQ@ ug AVM) Uidap uq 8|4 AVM Buineg
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( Setting MP3 file bit rate (MP3 Bit Rate) )

You can set the bit rate of recorded MP3 files.

—
1. Press [vews]. 4. use @ to select the bit MPS Bit Rate

128kbps

192kbps
rate, and press .

—x
2. Use @ to select REC, MENU

FINDER

META DATA (for Next Take)
and press . INPUT

OUTPUT

MENU : Return

REG HINT

PLAY This can be set to 128 kbps, 192 kbps or 320 kbps.

—
3- Use@to select MP3 Bit =

Rec to SD1 Tr1-8 (Poly)
Rec to SD2 Tr1-8 (Poly)
Sample Rate 48kHz
Ra t & and press @ ) WAV Bit Depth 24

MP3 Bit Rate 320kbps

Dual Channel Rec 4

MENU : Return




[Simultaneously recording tracks at different levels (Dual Channel Rec) j

Along with regular recording, the F8cn capture a second recording set to a different input level (dual channel recording).
For example, by using dual channel recording to record at an input level 12 dB below that of the regular recording, you have an
immediate replacement if the regular recording distorts because the track level is too high.
Dual channel recording can be used with tracks 1-4.

1.

2.

Press .

—x
Use @ to select REC,

and press @

=\
Use @ to select Dual

Channel Rec, and press @

MENU

FINDER

META DATA (for Next Take)
INPUT

QUTPUT

REC

PLAY

o
Tr1-8 ®oly)
Tr1-8 ®oly)

Rec to SD1
Rec to SD2
Sample Rate 48kHz
WAV Bit Depth 24

MP3 Bit Rate 320kbps
Dual Channel Rec »

MENU : Return

4.

=
Use @ to select the track,

and press @

Use to select On,

and press @

When dual channel recording is
on, the name of the correspond-
ing second track (5-8) changes.

)

Dual Channel Rec =)

Input 1

Input 2 Off
Input 3 Off
Input 4 Off
All 4

MENU : Return

Input 1

BC

Off

~ On

MENU : Return
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[ Simultaneously recording tracks at different levels (Dual Channel Rec) (continueda

6. Turn for the dual channel recording track to

adjust the input level.

For example, when track 1 is selected, adjust for track 5.

HINT
Dual channel recording increases the amount of space used on SD

cards.

e When using dual channel recording, the track that is numbered

4 higher than the original track is used for the second recording.
For example, track 5 is used for the dual channel recording of
track 1 and track 6 is used for track 2. Dual channel recording
tracks cannot be used independently.

* When dual channel recording is enabled, if stereo-linking is
enabled or disabled for tracks 1/2 or 3/4, the same setting will be
applied to tracks 5/6 or 7/8.

* The limiter, high pass filter and other functions can be set inde-
pendently for the regular and dual recording tracks.

e When a mic capsule is connected, its dual recording track input

level is fixed at -12 dB compared to the regular track.




[Capturing audio before recording starts (Pre Rec)

The input signal can be captured for up to 6 seconds before is pressed (pre-recording).

This is useful if, for example, is pressed too late.

File format Sampling rate Maximum pre-recording time
44.1kHz 6 seconds
1 Press -: .
- 47.952kHz 6 seconds
47.952kHz(F) 6 seconds
EQ 48kHz 6 seconds
2 = Use @ to select REC, MENU WAV 48.048kHz 6 seconds
FINDER
META DATA (For Next Take) 48.048kHz(F) 6 seconds
and press : NPUT 88.2kHz 3 seconds
SSCTP”T 96kHz 3 seconds
PLAY 192kHz 1 second
44.1kHz 6 seconds
MP3
48kHz 6 seconds
3 — NOTE
Use @ to select Pre Rec . . . . .
" ! Rec to SD2 Tr1-8 oy Pre-recording will be disabled if MENU >TIMECODE >Timecode >
Sample Rate 48kHz .
and press ) WAV Bit Depth 2 Mode (— P.126) is set to Int Record Run, Ext or Ext Auto Rec.

MP3 Bit Rate 320kbps
Dual Channel Rec »
Pre Rec Off

MENU : Return

4. Use

and press @

to select On, o¢
Off

+ On (6sec)

)

MENU : Return
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[ Maximum file size (File Max Size) ]

The maximum size of recording files can be set. If a recording file exceeds the maximum file size, recording will continue in a
new take with a number that is one higher. No gap will occur in the sound between the two takes when this happens.

=
1. Press - 4. use @ to select Size, Fle Max Size

Size

Time Counter
and press .

e\
2- Use @ to select REC, MENU =

FINDER »
META DATA (for Next Take) »
and press . INPUT '
QUTPUT >
REC >
PLAY 3 I
MENU : Return 5 = Use @ to select the
512MB
640MB
PSS — maximum size of recording -
= Use @ to select File Max Sampl Rate st _
WAV Bit Depth 2 files, and press .
: MP3 Bit Rate 320kbps
S.l Z€, and press @ * Dual Channel Rec »

Pre Rec Off

File Max Size > HINT

MENU- Return Setting the maximum size to 640MB or 512MB is convenient for

backing up to CDs.




[Showing total recording times for long recordings (Time Counter)

When recording for a long time, if the file size set with "File Max Size" is reached, recording will continue in a new take and
the recording time will reset. You can change this, however, so that it is not reset and the total recording time is shown.

1 = Press . 4.

FINDER

Py
2 = Use @ to select REC, M

AN . File Max Size
Use @ to select Time

Time Counter
Counter, and press @

Size

@ META DATA (for Next Take)
INPUT
and press . oUTPUT
REC
PLAY N Time Counter
: 5- Use @ to select : >
Reset
Continuous, and press @
3 =) .
= Use @ to select File Max sampie Rate
WAV Bit Depth
. MP3 Bit Rate
51 Ze' and press @ Dual Channel Rec
Pre Rec
File Max Size Setting value Explanation
When recording, even if the file size set with "Size" is
Continuous reached, the counter shown on the Home Screen will not
be reset.

Reset

When recording, if the file size set with "Size" is reached,
the counter shown on the Home Screen will be reset to
000:00:00.

(491un0) awi] ) sbuipiodas Buoj 1oy sewiy Buipiodal |elo) Buimoys
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[ Folder and file structure

When recording with the I B8, folders and files are created
on SD cards as shown below.
Folders and files are used to manage scenes and takes.

Folder and file structure

The folder and file structure differs according to the recording
file format. In addition, the names of folders and files depend
on how scenes are named.

Rolm Order recorded —

HINT

e A "take" is a unit of data created for a single recording.

* A "Scene" is a unit containing multiple files and takes that com-
prise a single scene.

NOTE

e Enabling recording on SD cards and setting file formats (— P.25)
e Setting how scenes are named (mode) (— P43)

E First scene

150101

150101-TO03.WAV

160101-T003_Tr1.WAV

D

E_I_

Scene 150101

Scene 150101

(1st take) (2nd take)
WAV format MP3 format
Poly file Stereo file

160101-T003_Tr2. WAV

— L]

160101-T003_Tr3. WAV

—U]

01-T003_Tr4 WAV

Scene 150101
(3rd take)
WAV format
Mono files (tracks 1-4)

E Next scene

150102
|

User created
folder

— )]

Stereo file (track 1-2)
Dual channel recording file (tracks 1-2)
Stereo file (L/R tracks)

Scene001-T001.WAV

— 1]

Scene 150102

(2nd take) Scene001-T001_Tr1. WAV
WAV format N
Poly file n

Scene001-T001_Tr2.WAV

— 1]

Scene001-T001_Tr3. WAV

—U]

Scene001-T001_Trd. WAV

150102-T001_Tr1_2_D.WAV

160102-T001_TrL_R. WAV

Scene 150102
(1st take)
WAV format

R L L L R T T TP

Scene Scene001
(1st take)
WAV format
Mono files (tracks 1-4)



Take names

Structure

Explanation

Scene001 T001

Take number
(001-999)
Scene number

(1-9999)
Scene name

Scene name: Select none, the folder
name, the date or a name input by
the user (= P43).

Scene number: Press +[(>] to
advance the number by one.

Take number: This number increases
by 1 for each recording made with
the same scene name and number.

Audio file names

File names are given by the 8 according to the file for-
mat—poly, mono or stereo.Track numbers and other data are
added to file names.

File names

File names are given according to the following formats.

Type Structure Explanation
This is a file created
Scene001-T001.wav by poly recording.
Poly file Audio for multiple
Take name tracks is recorded to
a single file.
Scene001-T001_Tr1.wav
Mono This is a file created
file Track number by mono recording.
Take name
Scene001-T001_Tr1_2.wav
Stereo |_ This is a file created
file Track number by stereo recording.
Take name
Dual Scene001-TO01_Tr1_D.wav o
channel Letter added to| This is a file created
record- dual channel | by dua_l channel
ing file Take name  Track number recording file | recording.
HINT

When recording with a Mono/Stereo setting, the audio files are

saved in the take folder that is created.

24N10N.1S 3|1} pue 18P|04
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[ Moving the previously recorded take to the FALSE TAKE folder

If the just recorded take was a failure, you can use a shortcut to move the recording to the FALSE TAKE folder.

1 = Open the Home Screen.

2 = Press and hold .

HINT
* Moving the take recorded most recently to the FALSETAKE folder

will reduce the number of the take recorded next by 1.
e Even during recording, you can move the previously recorded
take to the FALSE TAKE folder.

=}
3- Use @ to select Yes W 0000000 5ids 5o
'$ Move To FALSE TAKE Folder.
SD1:Scene001-TOOLWAYV
and press @ $D2:Scene001-TOOLWAV
Are you sure?

No




[Changing the note for the next take recorded (Note)

You can input characters for a note to use as metadata in the file.

1.

2.

Press .

—x
Use @ to select META

DATA (for Next Take),

and press @

e\
Use @ to select Note,

and press @

MENU 2.

oC
FINDER »
INPUT

QuTPUT

REC

PLAY

META DATA (for Next Take) @

Scene Name Mode Date
User Scene Name »

Scene Increment Mode Numeric
Track Name »

Take Reset Mode Folder Change

MENU : Return|

» Continue to one of the following procedures.

Editingnotes ...............

..................... P41

Selecting notes from the history list .. ............... P42

Editing notes

4.

—x
Use @ to select Edit,

and press @

Edit the note.

See "Character input screen"
(= P13) for how to input
characters.

Note |

=

Edit No Slate

History >

Return

No Slate

MENU : Cancel

|This note is written to the <NOTE> metadata.

(810N papl0oa. 8ye} 1Xau 8y} 1oy 81ou syl Buibuey)
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[ Changing the note for the next take recorded (Note) (continued)

Selecting notes from the history list

=) . Not —
4. use @ to select History, _ ote G
Edit No Slate
and press @

MENU : Return

History

bC

=\
5 = Use to select the item
T TE—
Environmental Noise
to use, and press . <None>

<None>
<None>
<None>

MENU : Return

The history list will be erased if the Factory Reset function is used.




[Setting how recorded scenes are named and numbered

You can set how scenes are named (name mode), the base scene name and how scene numbers advance.

Setting how scenes are named (mode)

1. Press . P
3. Use @ to select Scene Name

=\
2. Use @ to select META M = Mode, and press @

FINDER »
|
INPUT
DATA (for Next Take), ouuT
REC
and press @ LAY
4 =)
» Continue to one of the following procedures. = Use @ to select the mode,
Setting how scenes are named (mode). .............. P43 d @
an ress -
Changing SCENE NAMES. . .. v v vt i it i i P44 P
Selecting a scene name from the history list . ......... P45
Setting how scene numbers advance ................ P45

META DATA (for Next Take) @

Note 4
Scene Name Mode Date
User Scene Name »
Scene Increment Mode Numeric
Track Name >
Take Reset Mode Folder Change

MENU : Return|

Scene Name Mode L

None
Current Folder

User Name

MENU : Return

paJaquinu pue psweu 81e s8ueds peploosal moy Buimes
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[ Setting how recorded scenes are named and numbered (continued)

Setting value

Explanation

None

The scene name and number are not used.

When recording files are created, they are named only
with the take number, such as "T001", "T002", "T003" and
so on.

(= J+[>] cannot be used to advance the scene number
by 1.

Example: T001.wav

Current Folder

The name of the currently selected folder is used as the
scene name.

[=J+[>1] can be used to advance the scene number
by 1. After advancing the scene number by 1, the cor-
responding folder will be used as the recording des-
tination. If that folder does not already exist, it will be
created.

Example: FOLDER001-T001.wav

Date

The date is used as the scene name.

(=J+[>*] cannot be used to advance the scene number
by 1.

If recording occurs after the date changes, a scene folder
with the date will be created.

Example: 20150101-TO01.wav

User Name

A scene name input by the user is used.

[(=J+[>] can be used to advance the scene number
by 1.

No folder is created in this case.

Example: MYSCENEO001-T001.wav

Changing scene names

If Scene Name Mode is set to User Name, set the scene name
used like this.

e
3. Use @ to select User Scene

Name, and press @

META DATA (for Next Take) @

Note >
Scene Name Mode Date

User Scene Name >

Scene Increment Mode Numeric
Track Name >

Take Reset Mode Folder Change

MENU : Return

3 User 5 N; =)
to select Ed.l t, ser Scene Name —
Edit Scenel01

History >

4. Use @

and press @

MENU : Return

5 = Edit the scene name.

Scene(01]

See "Character input screen"
(= P13) for how to input
characters.

REW/FF:¢-/ >

NOTE

The scene name is written to the <SCENE> metadata.

MENU : Cancel

You cannot put a space or an @ mark at the beginning of the name.




Selecting a scene name from the history list

3.

e\
Use @ to select User Scene

Name, and press @

=) .
Use to select History,

and press @

=\
Use to select the item

to use, and press @

META DATA (for Next Take) (2]

Note »
Scene Name Mode Date
User Scene Name »

Scene Increment Mode Numeric
Track Name »

Take Reset Mode Folder Change

MENU : Return

User Scene Name {2

bC

Scene001

History

oc
Scene002 |
<None>
<None>
<None>
<None>

[ The history list will be erased if the Factory Reset function is used. |

Setting how scene numbers advance

e\
3. Use @ to select Scene

Increment Mode, and

press @ Take Reset Mode
=)
Use @

scene numbers advance,

and press @

META DATA (for Next Take)

Note
Scene Name Mode
User Scene Name

Track Name

Folder Change

MENU : Return

Scene Increment Mode

Character

to select how

Setting value

Explanation

Press + on the Home Screen to increase the

Numeric scene number by one.
Example: Scene = Scene1 — Scene2 — ... & Scene9999
Press (= ] + [>] on the Home Screen to advance the
capital letter at the end of the scene name by one.
Character If the scene name does not have a capital letter at its end,

one will be added.
Example: Scene1 = Scene1A — ScenelB — ... =
Scene1Z — Scene1AA — Scene1AB — ...

paJaquinu pue psweu 81e s8ueds peploosal moy Buimes
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[Setting the take name reset condition and format

You can set the take name reset condition and format used when recording.

1.

2.

Press .

)

MENU —
Use @ to select META FIORR K
|
DATA (for Next Take), INeuT

OuUTPUT

REC

PLAY
and press @

» Continue to one of the following procedures.

Setting the take name reset condition. . .............. P46
Setting the take name format....................... P47

Setting the take name reset condition

3 2N META DATA (for Next Take) ‘8]
= Use to select Take Reset | ,
Scene Name Mode Date
MO d e a nd ress @ User Scene Name: »
! P ) Scene Increment Mode Numeric

4. Use @

Track Name >

Take Reset Mode Folder Change

MENU : Return

to select the reset o Take Reset Mode

+ Folder Change
mode, and press .

Setting value

Explanation

Off

The take number will not be reset.

However, if the folder is changed and that folder con-
tains a number higher than the current take number,
the take number will be set to one higher than the
highest existing take number.

Folder Change

If the destination folder is changed, the take number
will be set to one higher than the highest take number
in that folder.




Setting the take name format

3 META DATA (for Next Take) {5
ATA (for Next Take
= Use to select ‘ o
Scene Name Mode Date
User Scene Name 4
T a k e N ame FO rmat Scene Increment Mode Numeric
’

Track Name 4

Take Mode Folder Change
I R
and press . Take Name Format Scene™T

MENU : Return

— Take Name Format
4. Use to select the ake Name Forma

Scene”_***
format, and press .

MENU : Return

Setting value Explanation

"Scene"-T***
Take name
Scene name

"Scene"-T***

Example: Scene001-T001

"Scene"_***

Scene name

Example: Scene001_001
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[ Changing the track name of the next take recorded (Track Name)

The track name set with the following procedure will be given to the next recorded track.

Track 1

@ Track 2
and press . Traces
=) p Track 4

2 = Use @ to select META HENJ

—
1. Press [, 4. use @ to select the track, N

Track ©

FINDER Track 6

META DATA (for Next Take) 4

DATA (for Next Take), TNPT
OUTPUT
@ REC » Continue to one of the following procedures.
PLAY
and press : Editing the track NAMEe ..« v« v vve e, P49
Selecting a track name from the History list. .......... P49
P .
META DATA (for Next Take) (221
3- Use @ to select Track ote \
Scene Name Mode Date
N ame d User Scene Name 4
» and press - Scene Increment Mode Numeric

HINT
On the Home Screen, + (2] can be used to open theTrack Name

screen.




Editing the track name

5- Use @ to select Edit, Track 1

and press @

6. Edit the track name.

See "Character input screen"
(— P13) for how to input
characters.

REW/FFi¢/ = MENU : Cancel

| The track name is written to the <TRACK> <NAME> metadata. |

Selecting a track name from the history list

=\
5- Use @ to select History,

and press @

e
6. Use @ to select the item

to use, and press @

The history list will be erased if the Factory Reset function is used.

Track 1

Mic
Line

Wireless
Mix
Actor

bC

Boom |
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[Changing the number of the next take recorded

The number given to the next recorded take can be changed when the Home Screen is open.

Press and hold .

e
Use @ to increase or

decrease the take number

by one, and press @

Next Take Number.
Scene001-T002

This function cannot be used during recording and playback or

when the scene naming method (Scene Name Mode) is set to Date.
You can change how scenes are named with the following menu
item.

MENU > META DATA (for NextTake) > Scene Name Mode




[ Playing recordings

i

[2) 2 [3) ke [4) P
(D= d);

75 75

200 @?%_n?? E]:'_'Po.n?? :l‘l‘nu_nqq
O OED

=

CHI®k!
RG]
St

HINT

[EJE][EJ?[E@

1 = Press .

= Playback operations
Select take or jump to mark:

Search backward/forward:

Pause/resume playback:

Tracks that have no playback files
appear gray.

L —1

Press or
Press and hold (=J/(=]
Press (=]

e The longer you press and hold [=]/[>=], the faster the backward/
forward search speed.

* During playback, press track keys to switch between playing back
(lit green) and muted (unlit).

* An "Invalid Take!" message will appear if the selected take is not
valid.

* A "NoTake!" message will appear if no take exists.

* During playback, you can press to add a mark that can be

used for skipping. (— P. 170)

2 = Press to return to the Home Screen.

sBuipioodas BulAeld
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[ Mixing takes

You can change the volume and panning of each track during playback.

1 = Open the mixer on the Home

Screen. (— P11)

2. Press to start

playback.

3 = Adjust the parameter settings.

See "Adjusting the input signal
monitoring balance" (= P75) for
how to change settings.

HINT

* You can turn @ to move the cursor, and also adjust the settings
of the MAIN OUT 1/2 and SUB OUT 1/2 tracks (— P116).

e When a fader or pan knob is selected, press and hold to
reset it to its default value. If already set to its default value,

selecting a fader mutes the track.

NOTE

e Settings are saved separately for each take and are used during

playback.

e Mix settings are not saved with the take when the format is MP3.




[ Monitoring the playback signals of specific tracks during playback

You can monitor the playback signals of specific tracks using SOLO mode.

1 = Open the Home Screen.

2. Press to start

playback.

3 = Press on the tracks that

you want to monitor.

The background colors for the
selected tracks will become
green, and their track indicators
will light orange.

Scene001-T001

—45 -20  -16  -12 -6

+ WAU 48.000
SD2 : MP3 320kbos

Scene001-T001
-6 -1z -

-20

BB : wav 98.000  (DEZEE)

Scene01-T001

-45 -20  -16 -12

B v 48.000  (DDEE

SOLO mode can only be used with tracks that can be played back

(indicators lit green).

4. Press of a track being monitored to stop

monitoring it.

soegAe|d Burinp syoeu oiy109ds Jo sjeuBis yoeqAe|d ay) Bulionuoy
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[ Changing the playback mode (Play Mode)

You can change the playback mode.

1.

2.

Press .

=X
Use @ to select PLAY,

and press @

=\
Use @ to select Play Mode,

and press @

=\
Use @ to select the play

mode, and press @

MENU

FINDER

META DATA (for Next Take)
INPUT

QUTPUT

bC

Play Mode Play One

MENU : Return

Play Mode
Play One
+ Play Al
Repeat One

Repeat Al

MENU : Return

Setting value Explanation
Play O
-ay ne Only the selected take will be played.
(single playback)
Play All Takes will be played back continuously from
(all playback) the selected one until the last take.
Repeat One
Th lected take will be played tedly.
(single repeat playback) e selected take will be played repeatedly.
Repeat All All takes in the selected folder will be played

(all repeat playback)

repeatedly.




( Take and folder operations (FINDER)

)

The FINDER allows you to select and view the contents of SD cards, takes and folders, and to create project/scene folders. It also
allows you to, for example, set and delete recording/playback folders and view their information.

1.

Press .

—x
Use @ to select FINDER,

and press @

=)

Turn @ to select the SD

card, folder or take that you

want to use.

= Editing operations

Move cursor:

Move down a level:

Move up a level:

)
Turn @
Press @

Press

MENU
FINDER
META DATA (for Next Take)
INPUT
QUTPUT
REC
PLAY

FINDER

<£SD1 : F8_SDL Q‘ee:

so SD2 : F8_SD2 Remain: 003h50)

ENC (hold) : Option

= SD card selected
FINDER

% SD1 : F8_SD1

5o SD2 1 F8_SD2

ENC (hold) : Option

= Folder selected
23 SD1 : F8_SD1

T TRASH »
WAFALSE TAKE 4

= 170101 »

Ei Scene001-T001
&4 Scene001-T002
Bl New Folder

ENC (hold) : Option

= Take selected
50 SD1 : F8_SD1

W TRASH
W& FALSE TAKE
170101 »

Ei Scene001-T001

&4 Scene001-T002

Bl New Folder 4
ENC (hold) : Option

oC
Date: 17/01/01
Time:  15:32:30]

FPS:
Len:

SideMicLvl:
MENU : Return

Free space
Size
Recordable time

Date
Time

Timecode

Frame rate
Length

Recording format
Date created
Time created
Size

MS Side mic level

(430NI4) suonetado Jap|o} pue exe|
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[ Take and folder operations (FINDER) (continued)

Creating folders

* When the cursor is on a take, you can press to play the Folders can be created inside the currently selected SD
selected take.You can also use [=], and [(=]. card/folder.
e A check mark appears on the playback take and recording/play- P
4 20 SD1 : F8_SD1
back folder. = Use @ to select New 1l TRASH
BEFALSE TAKE
170101
Folder, and press @ B Scene001_To01
P Continue to one of the following procedures.
Creating folders .....cccoivieiiiiee e P56
Selecting the take recording/playback folder.................. P57
Checking take marks and using them for playback........ P57
Changing folder and take names..........cccccceecveirierinnnen. P58 5 =« Edit the folder name.
Copying takes to other cards and folders ...................... P58 .
. See "Character input screen"
Deleting folders and takes (— P13) for how to input
Emptying the TRASH/FALSE TAKE folder........cccceeeeurneen. P.60 char:acters.

REW/FF:¢-/ = MENU : Cancel

e The folder created will be set as the recording folder.

e The name of the folder created is written to the <PROJECT> or
<SCENE> metadata.
¢ You cannot put a space or an @ mark at the beginning of the

name.




Selecting the take recording/playback folder

Use this procedure to select the folder that contains the take
to be played or the folder to use for recording takes.

Opti
4. bpress and hold @ P
Rename

Select
=)
use @ to select Select, _
Meta Data Edit

Mark List
Copy
and press . Delete

Scene001-T001

¢ The first take inside the selected SD card or folder will be set as

the playback take.
e After selecting the take recording/playback folder, the Home

Screen will reopen.

Checking take marks and using them for playback
You can view a list of the marks in a recorded take.

4- Press and hold @ Option

Select
Mark List
Rename

=)
use @ to select Mark List, _
Meta Data Edit

Copy
and press . Delete
=\
5- Use @ to select a mark, and press @

The Home Screen will reopen, and playback will start from
the mark.

Scene001-T001

Mark List
000:00:10
000:00:20
000:00:30
000:01:00
000:10:00
001:00:00

o1

Added Mark

Indicates that a mark
was added during a
recording error.

MENU : Return
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[ Take and folder operations (FINDER) (continued)

Changing folder and take names Copying takes to other cards and folders

(43aNI4) suonelado Jap|oy pue axel
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4. press and hold @ ovten 4. Ppress and hold @ Option

=\
use @ to select Rename,

and press @

5 = Edit the folder/take name.

See "Character input screen"
(— P13) for how to input
characters.

Select

Mark List

Rename Scene001-T001

Meta Data Edit
Copy
Delete

Rename
Scene002-T001

MENU : Cancel

e The edited name of the folder/take is written to the
<PROJECT> or <SCENE> metadata.

* You cannot put a space or an @ mark at the beginning of

the name.

=\
use @ to select Copy,

and press @

=\
Use @ to select the take to

copy, and press @

Press and hold @

Select

Mark List

Rename Scene001-T001
Meta Data Edit >

Delete >
MENU : Return|

Copy

b
O Ej Scene001-T002
O B Scene002-T001
O B Scene002-T002
O K Scene003-T001
O B Scene003-T002

PLAY - All ENC thold) : Copy to




=
7. Use @ to select the

copy destination, and

press and hold @

Copy to

e

I Scene(01 p| |Date: 17/01/06)
153251
I Scene002 »
I Scene003 »
»

Time::

I Scene004

ENC (hold) : Execute MENU : Return|

NOTE

| See "Take and folder operations" for how to select a folder. (— P55) |

e\
8. Use @ to select Yes,

and press @

Copy

Are you sure?

No

MENU : Return

Deleting folders and takes

4. Press and hold @

e
use @ to select Delete,

and press @

=\
5 = Use @ to select the

folder/take to delete, and

press @

Press to cancel deletion.

Option

Select

Mark List

Rename Scene001-T00L
Meta Data Edit »
Copy >

Delete »

Delete

[0 m170101
O K Scene001-T001

Ei Scene001-T002

ENC thold) : Execute

You can press to select/deselect all the folders and takes that

are currently shown.

6- Press and hold @

(43aNi14d) suone)ado 18p|o} pue aye|
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[ Take and folder operations (FINDER) (continued)

Emptying the TRASH/FALSE TAKE folder

e\
7. Use @ to select Yes, Delete

=\
55D1: F8_SD1 )
— 4. use( ) to select TRASH = s
re you sure? il ey
and press . MAFALSETAKE b |
170101 ’
N
° or FALSE TAKE. & New Folder »

MENU : Return

* Deleted folders and takes are not immediately erased from the
SD card.They are moved to the TRASH folder. % SD1: F8_SD1

. . . T Date: 17/01/01
e Deleting the folders and takes in the TRASH folder will com- Time: 114455
pletely erase their data. 170101

»
BNew Folder »

[ENC (hold) : Option

FALSE TAKE folder



=X
6. Use @ to select Empty, Option

and press @

MENU : Return

P

7. Use @ to select Yes, Fmpty

Are you sure?
and press .

No

MENU : Return

e Emptying the TRASH folder will completely erase the data in it.

e Emptying the FALSE TAKE folder will not immediately erase the
data in it from the SD card. Instead, this data will be moved to
the TRASH folder.

61
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[Overview of take information (metadata) stored in files

The IF BB writes a variety of information (metadata) to files
during recording.

When these files are read by an application that supports
metadata, you will be able to check and use the saved
information.

HINT

* Metadata is data that contains information related to other data.
The I BB saves scene names and take numbers, for example,
as metadata in audio files.

e A chunk is a unit that contains multiple data in a single block.

e To use BEXT and iXML chunk metadata, an application that sup-

ports both data formats is necessary.

WAL file metadata

The metadata saved in files recorded by the =8 inwav
format is collected in BEXT (Broadcast Audio Extension) and
iXML chunks.

For information about the metadata saved in these chunks,
see the “Metadata contained in BEXT chunks in WAV files”
(— P186) and “Metadata contained in iXML chunks in WAV
files” (= P187).

MP3 file metadata

The metadata saved in files recorded by the =8 in vr3
format is written as ID3v1 tags.

For information about the ID3 fields and formats for saving
metadata, see the "Metadata and ID3 fields contained in MP3
files" (— P.189).

HINT

o F B \viP3 files conform to the MPEG-1 Layer Ill standard.
¢ MP3 metadata cannot be edited.




1.

=y
2. Use @ to select FINDER,

Press .

and press @

P

Use @ to select the take,

and press .

This opens the Option Screen.
See “Take and folder operations”
for how to use the Finder. (= P55)

—x
Use @ to select Meta Data

Edit, and press @

MENU

FINDER

META DATA (for Next Take)
INPUT

QUTPUT

REC

PLAY

sp SD1 ¢ F8_SD1

F TRASH

A FALSE TAKE
170101

B Scene001-T001

& Scene001-T002 Time:

= Size:
Bl New Folder ¥ | SideMicLvi:

ENC (hold) : Option MENU : Return

Option

oC
Select

Mark List »
Rename Scene001-T001

Meta Data Edit »

Copy 3
Delete »

MENU : Return|

» Continue to one of the following procedures.

Checking and editingnotes ..................cvuun P64
Selecting notes from the history list . ................ P64
Checking and editing scenenames . ................. P65
Selecting a scene name from the history list . ......... P65
Checking and editing takenames ................... P66
Circlingtakes...........ciiiiiiii i P67
Editing folder (tape)names ........................ P67
Editing projectnames. . ........ ... . i P68
Checking and editing tracknames................... P68
Selecting a track name from the History list........... P69
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( Checking and editing take metadata

Checking and editing notes

=\
5- Use @ to select Note,

and press @

—x
6- Use @ to select Edit,

and press @

7. Edit the note.

See "Character input screen"
(— P13) for how to input
characters.

Meta Data Edit =

oG

Scene »

Take 3

Circle Not Circled
Folder(Tape) Name 170101
Project Name 170101

MENU : Return|

bC

E No Slate

Hist 4

Return

MENU : Cancel

REW/FF:¢/ >

NOTE

| The content of this note is written to the <NOTE> metadata. |

Selecting notes from the history list

=\
5- Use @ to select Note,

and press @

=\
6- Use @ to select History,

and press @

=
7. Use @ to select the item

to use, and press @

Meta Data Edit =

oG
Scene >
Take 3
Circle Not Circled
Folder(Tape) Name 170101
Pro ject Name 170101

MENU : Return|

bC

Edit No Slate

History »

MENU : Return

History —

+ No Slate |

Environmental Noise
<None>
<None>
<Nonhe>
<Nonhe>

MENU : Return

[ The history list will be erased if the Factory Reset function is used. |




Checking and editing scene names Selecting a scene name from the history list
=\ =
i (=3 i =m)
5. Use @ to select Scene, Meta Data Lt G 5. use @ to select Scene, Meta Data Lt G
Note » Note >
Scene C
and press @ Take 1 and press @ Take 1
Circle Not Circled Circle Not Circled

Folder(Tape) Name
Project Name

Folder(Tape) Name
Project Name

— . . — — ' - —
6- Use @ to select Edit, o o 6- Use @ to select History, cene o
Scene001 Scene001
y
and press @ and press @

= _
7. cdit the scene name. 7. Use @ to select the item Hstory v
Sconot0l e E—
See "Character input screen" Scene002
(= P13) for how to input to use, and press @ :2::2
characters. <None>

<None>

NOTE NOTE

|The scene name is written to the <SCENE> metadata. | |The history list will be erased if the Factory Reset function is used. |
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[ Checking and editing take metadata (continued)

Checking and editing take names

Meta Data Edit =m)
5- Use @ to select Take, era tatatd o

Note >
»

Scene
and press . 2ke
Circle Not Circled

Folder(Tape) Name

Project Name

6- Change the take number.

MENU : Cancel
= Editing operations

P}
Move cursor or change value: Turn @

Select parameter to change: Press @

HINT

This can be set from 1 to 999.

NOTE
| The take number is written to the <TAKE> metadata.

7.

When done changing,

e\
use @ to select Enter,

and press @

\ Enter |

MENU : Cancel




Circling takes

Use this function to add an @ mark to the beginning of the
name of the best take to make it stand out. This is called a
"circled take".

=\
5- Use @ to select Circle, Meta Data Edit -

Note

3

Scene »

and press . Take 3
Circle Not Circled

Folder(Tape) Name 170101
Project Name 170101

MENU : Return|

=\
6- Use @ to select Circled, Circle -

Not Circled
and press @

+ Circled

MENU : Return

e To clear a circle, select Not Circled and press @

e This circled status is written to the <CIRCLE> metadata.

Editing folder (tape) names

=) —
Meta Data Edit
5- Use @ to select Folder " e ¥
lote >
Scene >
Take 3
(Tape) Name' and press @ Circle Not Circled

Folder(Tape) Name 170101

Project Name 170101
MENU : Return

Folder(Tape) Name
170101

6- Edit the folder (tape) name.

See "Character input screen”
(— R13) for how to input
characters.

e The folder (tape) name is written to the <TAPE> metadata.

e The folder (tape) name used immediately after recording is the
name of the folder in which the take was recorded.
* You cannot put a space or an @ mark at the beginning of the

name.
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[ Checking and editing take metadata (continued)

Editing project names Checking and editing track names
=) — )
. Meta Data Edit Meta Data Edit
5. Use@to select Project \ e ¥ 5. Use@to select Track e
ote 4 Scene
Scene 4 Take
Take 3 Circle Not Circled
Name' and press @ Circle Not Circled Name' and press @ Folder(Tape) Name Pro ject001

Pro ject Name Pro ject001

Track Name »

Folder(Tape) Name 170101
Pro ject Name 170101

MENU : Return

j AN
6. Edit the project name. Project Nare o
) prol 170101 6. use to select the track, s
See "Character input screen" Track 1

Track 2
— P13) for how to input 5
( 3) 0o O (o] P and press @ Track 3
characters. Track 4

Track Trd

Track 6 Tr6
MENU : Return

® The project name is written to the <PROJECT> metadata. —
e The project name used immediately after recording includes the 7_ Use @ to select Edit, Track 1
name of the highest level folder (inside the SD card root direc-
tory) that contains the folder in which the take was recorded. and press @

* You cannot put a space or an @ mark at the beginning of the

name.




8 = Edit the track name.

See "Character input screen"
(— P13) for how to input
characters.

REW/FF:</ - MENU : Cancel

The track name is written to the <TRACK> <NAME> metadata.

Selecting a track name from the history list

=\
5- Use @ to select Track

Name, and press @

=\
6- Use @ to select the track,

and press @

=y
7. Use @ to select History,

and press @

Meta Data Edit

Scene

Take

Circle Not Circled
Folder(Tape) Name Pro ject001
Pro ject Name Pro ject001
Track Name »

MENU : Return

Track Name

Track 1
Track 2
Track 3
Track 4
Track
Track 6

Track 1
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[Checking and editing take metadata (continued)

=)
8- Use @ to select the item ISt

Boom |

Mic
to use, and press @ Lo
Wireless

Mix
Actor

MENU : Return

The history list will be erased if the Factory Reset function is used.




[Writing sound reports (Create Sound Report) j

A sound report includes information about recording times and takes.
Reports can be written as CSV format files (F8_[folder name].CSV). You can edit the comments written in sound reports.

=
Optio
1 = Press . 4- Use @ to select t Lk G
elec

—x Create Sound Report,
2. Use @ to select FINDER, — ik *:j'
o )
META DATA (for Next Take) » | and press :
and press @ !
C »
» » Continue to one of the following procedures.
MENU : Return .
Writingasoundreport ............ ..., P.72
Editingcomments............. ... i, P.72
A Selecting comments from the history list P.73
[— electing comments from the history list............ d
3- Use @ to select the folder . L 9 Y

53 D2 : F8_SD2 Remain: 00350
or SD card for which you

want to create a sound

ENC ¢hold) : Option

report, and press and

hold @
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[Writing sound reports (Create Sound Report) (continued)

Writing a sound report

5.

=)
Use @ to select Create,

and press @

e\
Use @ to select Yes,

and press @

This writes the sound report
inside the selected SD card or
folder.

Create Sound Report ]

e

Info Edit »

Create

Are you sure?

* Only information about takes in the folder or SD card is written

in the sound report.

¢ |If a sound report file with the same name already exists, it will be

overwritten. Please use caution.

Editing comments

5.

=)
: Sound [
Use @ to select Info Edit, Create SoundReport 52
Create »
and press .

)

Use to select Comments,

and press @

=
Use @ to select Edit,

and press @

Edit the comment.

See "Character input screen"
(— P13) for how to input
characters.




Selecting comments from the history list

5.

=\
. Sound =
Use @ to select Info Edit, Create SondReport 52
Create >
and press .

Use to select Comments,

and press @

)

MENU : Return
=)
Use @ to select H'| Story, Comments o
and press .

=\
8- Use @ to select the item " =

<None>
to use, and press . <None>
<None>

<None>

<None>

HINT

The history list will be erased if the Factory Reset function is used.
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Recording

S ] PG L [ S, \A*/ ||||||| n_/l |||||||||||||||| J
-« ~ . o« _ Output On/Off, Level _
3 3 3 8 3 3 I T
S ® o © o o
[ = = - (=S = _ Output Delay __ Level _
| | |
Slate Mic/Tone _ _ Slate Mic/Tone _
| | |
_ Output Limiter _ _>_m2 Tone _
| |
_ Fader _
| |
_ Routing _
i
L o

Input Delay

MS Stereo

Phase Invert

Input Limiter

HPF

Trim

Dual Channel Rec

[ Input and output signal flow

Input 1
Input 2
Input 7
Input 8

Input and output signal flow
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[Adjusting the input signal monitoring balance ]

You can adjust the volume and panning of each input signal when monitoring during recording.

1 = Open the mixer on the Home

Screen. (- P11)

2 = Adjust the parameter settings.

= Editing operations

Move cursor or change value:

Select parameter to change:

=y
Turn @
Press @

HINT

Parameter Setting range

Explanation

Fader Mute, -48.0 — +24.0 dB

Adjusts the level of the input
signal.

* You can turn @ to move the cursor, and also adjust the settings
of the MAIN OUT 1/2 and SUB OUT 1/2 signals. (= P116)

e When a fader or pan knob is selected, press and hold @ to
reset it to its default value. If already set to its default value,

selecting a fader mutes the track.

e The MAIN OUT 1/2 and SUB OUT 1/2 faders do not affect the

levels of the slate mic and slate tone.

e These volume and pan settings only affect the monitoring signals
and the data being recorded on the L/R track.

e Settings are saved separately for each take that is already
recorded and can be changed during playback. (— P52)

* Mix settings are not saved with the take when the recorded file

format is MP3.

Panning L100 - Center - R100

Adjusts the left-right stereo
position of the sound.
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[Setting the track knob function (Track Knob Option)

The Home Screen layout and track knob functions can be changed.

Setting the track knob function Adjusting faders with track knobs

This restricts the track knob function to changing fader values.

1_ Press _ This mode makes it easy to check volume changes due to
greater values and Auto Mix. (— P. 99)

P
MENU
2. Use @ to select SYSTEN, —
RUT 4 Track Knob Option =
REC = Use to select Fader, and )
and press PLAY. g
SLATE press . Mixer
—x —
SYSTEM
3. Use @ to select Track Knob _ -
Home Timecode Display Size Srmall
Level Meter 5- Open the mixer on the Home
: LED Brightness
Option, and press . L

PLAY Key Option Screen.
Track Knob Option

» Continue to one of the following procedures.

Adjusting faders with track knobs . . ................ P. 76

Adjusting fader and pan settings with track knobs .... P 77 6 U h _, ¢ " q |
= Usethe { || } for a track to adjust its volume.
10 75



HINT

TheTRIM and L/R figure values can be changed as follows.
=

Move cursor, change setting value: Turn @

Select parameter to change: Press @

Adjusting trim, fader and pan settings with track
knobs

The track knobs can be used to quickly adjust the fader and
pan settings of each track.

=\
4. Use @ to select Mixer,

and press @

Track Knob Option ()

5. Open the mixer on the Home

Screen.

wa
SDZ : MP3 320Kkbos

=\
6. Use @ to select the

parameter you want to adjust,

and press @

7. Use of the track you want to adjust to change

Er ]
its setting value.
HINT

The position of the knob on the display always shows the current setting.

After changing the parameter be adjusted, for example, if the posi-
tions of @- and the knob on the display are different, the knob on
the display will appear gray, and movmg @ will not affect that
setting. In this case, if you adjust {
knob on the display, the dlsplay knob and @ will be relinked, and

you will be able to use {

F to match the position of the

to adjust its setting value again.

Parameters with setting values and

@ positions that are different

10=="75

BB : Wiy 48.000
SD2 : MP3 320kbes

(uondQ gouy yoel]) uonouny qouy yoell 8yl Bumes
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[ Adjusting the L/R track volume

1 = Open the Home Screen.

2. Press + .

| Shortcuts are disabled during playback. |

3. Use @ to adjust the .L,RUOO'OO'OO 01581 %

volume.
Scene001-T001

-6 -1z

Bl : WAY 48.000
SD2 : MP3 320kbes.

* Volume settings affect the results of recording.
e If only the L/R track is recorded, the L/R track fader setting for the
take will be saved as 0dB.

4. When finished adjusting, press or + .

This is only enabled when Track Knob Option is not set to Fader.

P}
When set to Fader, you can adjust by using © to select.




[ Monitoring the input signals of specific tracks (PFL/SOLO) ]

You can monitor the input signals of specified tracks. Even tracks that have not been set to record can be input to the PFL screen
and their input sounds monitored. This is convenient when using tracks as return inputs. You can also make various settings for
these tracks.

Parameter Explanation
1 = Press on the tracks that you want to monitor. Phase Invert This sets the phase._ S
Side Mic Level This sets the side mic level of a mid-side mic capsule.
The selected track keys will light orange, and the PFL screen Input Delay This sets the input delay.
will open. Plugin Power This sets the plugin power.
"PFL" or "SOLO" appears at the top of the display, and you Stereo Link This sets the stereo link.
will be able to monitor the input signal with headphones. Stereo Link Mode | This sets the stereo link mode.
PFL mode PFL Mode This sets the monitoring volume on the PFL screen.
Track name
?I NTE :
Trim  Mic+31dB  Line:+11dB This does not change the signals output from MAIN OUT and SUB
Input Source Analog Input OUT.
Trim Mic:+31dB Linei+11dB Parameter names
Phantom +A8Y HINT
HPF Off
Input Limiter Use @ to select parameters and change setting values.
TN | , Level meter
-45 -20 -16 -12 -6 0 (prefader input

MENU : Return signal level)

2 = Press or for the monitored tracks.

Parameter Explanation
Input Source This sets the input source. Open the Home Screen.
Trim This sets the input level.
Phantom This sets phantom power.
HPF This sets the high pass filter.
Input Limiter This sets the limiter.
Fader This sets the fader level.
Pan This sets the panning.
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[Setting the input source (Input Source)

Follow these procedures to set the input source of each track.

1.

2.

Press .

)

Use @ to select INPUT, and

press @

—=x
Use @ to select Input

Source, and press @

=\
Use @ to select a track, and

press @

MENU =z

FINDER
META DATA (for Next Take)

4
»

Input Source
Ambisonic Mode
HPF

Input Limiter
Phase Invert
Phantom

Input Source —

Input 1 Analog Input
Input 2 Analog Input
Input 3 Analog Input

Input 4 Analog Input
Input 5 Analog Input
Input 6 Analog Input

MENU : Return|

HINT

Select ALL to set all the tracks at the same time.

~ Input 1
5 = Use to select the input i o
+ fnalog Input
USB 1
source, and press . UsB 2
USB 3

UsB 4

Setting value Explanation
Analog Input T.his treats signals input through INPUT 1-8 as input
signals.
USB 1, USB 2, When Audio Interface with Rec (— P.147) is set to On,
USB 3, USB 4 computer output signals are treated as input signals.

e When a mic capsule is connected, the Input Source cannot be
changed for Inputs 1 and 2.

e When dual channel recording is enabled (—»P.33), the Input Source

cannot be changed for the dual channel recording tracks.




[Setting the monitoring volume on the PFL screen (PFL Mode)

On the PFL screen, you can set the monitored sound to be either prefader listening (PFL) or postfader solo (SOLO).

—x
1 = Press . 4- Use @ to select the track,

and press @

—x
2. Use @ to select INPUT, M I

FINDER

META DATA (for Next Take)
and press .

Input 1
Input 2
Input 3

Input 4
Input 5
Input 6

PFL Mode

MENU : Return

HINT

Select ALL to set all the tracks at the same time.

—x
3 2\ 5- Use @ to select the mode,
= Use to select PFL Mode,

=m
Phantom
Plugin Power an d press .
and press . Tnput Delay

Stereo Link Mode

Input 1

Trim Link
MENU : Return
MENU : Return
Setting value Explanation
PFL Monitor the prefader sound.
SOLO Monitor the postfader sound.

When the PFL screen is open during playback, the monitoring

sound will be post-fader (SOLO) regardless of the setting.
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[ Cutting low-frequency noise (HPF) ]

The high pass filter can cut low frequencies to reduce the sound of wind, vocal pops and other noise.

=
1 = Press . 4. Use @ to select the input, -

Input 1 Off

Input 2 Off
and press Input 3 off
Input 4 Off

Input 5 Off
Input 6 Off

MENU : Return

FINDER

META DATA (for Next Take)
and press . N

QUTPUT

REC HINT

PLAY - -
Select ALL to set all inputs at the same time.

=X
2. Use @ to select INPUT, M

3 —
(| k N
= Use @ to select PF, HPE > 5 = Use @ to set the cutoff Toput 1

Input Limiter »

and press @ . Phase Invert »
Phantom > frequency, and press .
Plugin Power Off
Input Delay »

MENU : Return

MENU : Return

NOTE

| The HPF also affects dual channel recording data. |

HINT
This can be set to Off or between 10 and 240 Hz.




[ Input limiter

The limiter can prevent distortion by controlling input signals
that have excessively high levels.

Original hielease

. time
signal

Limited
signal \

Attack
time
Level

Threshold

Time

When the limiter is ON, if the input signal level exceeds the
set threshold value, the signal level will be suppressed to pre-
vent the sound from distorting.

The attack time is how long after the signal exceeds the
threshold before the limiter starts operating. The release time
is how long after the signal goes below the threshold before
the limiter stops operating.You can change these two param-
eters to adjust the sound quality.

HINT
e The F 8 has a newly designed limiter that provides 10 dB

of headroom, allowing signals to be kept well below the set

threshold, therefore more effectively preventing distortion.

1 = Press .

—x
2- Use @ to select INPUT,
FINDER

META DATA (for Next Take)
and press . AL
OUTPUT

REC
PLAY

=
3. Use @ to select Input et =

HPF »
Limiter, and press @

Input Limiter »

Phase Invert >
Phantom >
Plugin Power Off
Input Delay 4

MENU : Return

Input Limiter |

bC

=)
4- Use @ to select the input,
Input 1 »

Input 2 >
and press . Input 3 »
Input 4 »
Input 5 »

Input 6 4
MENU : Return

HINT

Select ALL to set all the inputs at the same time.
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[ Input limiter (continued)

» Continue to one of the following procedures.

Using the limiter....cccccciiiiiiiiiii e P84
Setting the type P85
Setting the threshold... ..P.86

Setting the attack time P86
Setting the release time......cccccvevevciieicccee e, P87
Setting the target level ... P88

On (Normal)

Peak might remain

-------------------- threshold

Before limiter After limiter

On (Advanced)

Sudden peaks are
suppressed by detecting
maximum levels in advance

target
level

Before limiter After limiter

Using the limiter
==\
5- Use @ to select On/Off, Input 1

and press @

=\
6- Use @ to select the owort

Off
=
setting, and press @

On (Advanced)

Setting value Explanation

Off This disables the limiter.
On (Normal)

This applies an ordinary limiter. The ratio is 20:1.

By detecting the maximum level in advance, this optimized
limiter prevents distortion even more than ordinary limiter
On (Advanced) .p . e . M
operation. The ratio is c:1, providing increased internal

headroom.

When set to On (Advanced), the input latency of the I B3
increases 1 ms. When monitoring sounds being recorded with a
mic in real-time, increased latency can cause interference between
sound transmitted through the air from the source and the delayed
monitored sound, possibly making accurate monitoring of the

sounds difficult.




e When set to On (Advanced), the following limiter parameter
becomes available to set.
-Target Level

e When set to On (Advanced), the following limiter parameters
cannot be set.
-Type
-Threshold
- AttackTime
- Release Time

e When set to On (Advanced), the Sample Rate cannot be set to 192
kHz. Moreover, when the Sample Rate is set to 192 kHz, the On

(Advanced) setting cannot be selected.

Setting the type
=)
Tnput 1 |
5- Use @ to select Type,
On/Off On (Normal)
@ Type Hard Knee
Threshold - 2dBFS
and press ) Attack Time Ims
Release Time 200ms
MENU : Return
=\
T =
6- Use @ to select the type, e o

Soft Knee
and press .

MENU : Return

Setting value Explanation

Only peaks that exceed the threshold are attenuated. There
Hard Knee .

is no effect below the threshold.
Soft Knee The limiter gradually affects the signal about 6 dB below

the threshold for a gentler effect.

This setting can be made when On/Off is set to On (Normal).
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[ Input limiter (continued)

Setting the threshold

This sets the level at which the limiter begins operating.

=)
Tnput 1 |
5. use () toselect Threshold,
On/Off On (Normal)
@ Type Hard Knee
Threshold - 2dBFS
and press : Attack Time Ims

Release Time

200ms

MENU : Return

e
6 = Use @ to adjust the Threshold

setting, and press .

MENU : Return

HINT

This can be set from -16 to -2 dBFS.

Setting the attack time

This sets the amount of time until limiting starts after the
input signal exceeds the threshold.

=\ —
Input 1
5- Use @ to select Attack A

On/Off On (Normal)

Type Hard Knee
. Threshold - 2dBFS
T1 me, and Press @ . Attack Time 1ms

Release Time

=y
6- Use @ to adjust the time, Attack Time

and press .

MENU : Return

HINT

| This setting can be made when On/Off is set to On (Normal).

This can be set from 1 to 4 ms.

NOTE
| This setting can be made when On/Off is set to On (Normal). |




)

Setting the release time

This sets the amount of time until limiting stops after the
input signal goes below the threshold.

=\ —
Input 1
B. use @ to select Release A

On/Off On (Normal)
Time, and press @

Type Hard Knee
Threshold - 2dBFS

Attack Time 1ms

Release Time 200ms

MENU : Return

Release Time

=\
6- Use @ to adjust the time,
and press .

MENU : Return

HINT

e Limiter operation is linked for tracks that have stereo link or MS
stereo link enabled. If the signal for either linked channel reaches
the threshold, the limiter will operate on both tracks.

e When the limiter is operating, the right-most segment of the level

meter and the mixer limiter indicator on the display light yellow.

| This setting can be made when On/Off is set to On (Normal). |

Jaywi| indu|
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[ Input limiter (continued)

Setting the target level

When the limiter On/Off setting is set to On (Advanced), use
this to set the target output level for the signal.

=}
5- Use @ to select Target Tnput 1 T

On (Advanced)

Level, and press @

Target Level + 0dBFS

MENU : Return|

=}
6- Use @ to adiust the Target Level

setting, and press .

HINT
e This can be set from -16 to 0 dBFS.

* After a signal passes through the limiter, it will not exceed the set

target level value.

This setting becomes available when On/Off is set to On (Advanced).




[ Inverting the input phase (Phase Invert) ]

The phase of the input signal can be inverted.
This is useful when sounds cancel each other out due to mic positioning.

Phase Invert |

1 = Press .

=
4. Use @ to select the input,
Input 1

Input 2 Off
and press Tnput 3 Off
Input 4 Off

N
MENU (]
2 = Use @ to select INPUT, Input 5 off
FINDER » Input 6 off
META DATA (for Next Take) » MENU : Return
and press . INPUE
QUTPUT

»
REC »
PLAY 4

MENU : Return|

HINT
Select ALL to set all inputs at the same time.

P

3 [
= Use @ to select Phase >

HPF
Invert, and press @

Input Limiter

»
»

Phase Invert »

Phantom »
Plugin Power Off
Input Delay 3

MENU : Return

=)
5. Use @ to select On, Input 1 =

and press @

Off

MENU : Return
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[Changing the phantom power settings (Phantom)

The F B3 can provide phantom power. The voltage can be set to +24V or +48V and it can be turned on/off for each input
separately.

HINT
Phantom power is a function that supplies power to devices that 1 = Press -

require an external power supply, including some condenser mics.

The standard power is +48V, but some devices can operate with

3
lower voltages. 2 = Use @ to select INPUT, M -

FINDER

>
META DATA (for Next Take) >
NOTE INPUT
and press .

Do not use this function with a device that is not compatible with E

REC
phantom power. Doing so could damage the device. PLAY

e
3. Use @ to select Phantom, et

HPF

Input Limiter
and press Phase Invert
Phantom

Plugin Power
Input Delay

MENU : Return

» Continue to one of the following procedures.

Using phantompower ........... ... ... ..., P91
Settingthevoltage ............ ... .. . it P91
Disabling phantom power during playback ........... P92



Using phantom power

=)
Phant =]
4. use( ) toselect 0n/0f1, o=
Voltage (For All Inputs) +48V
and preSS ) Power Saving (For All Inputsy ~ Off

=\
5- Use @ to select the input, ovore

Input 1

Input 2
and press . Input 3
Input 4
Input

Input 6
MENU : Return

HINT
Select ALL to set all inputs at the same time.

=) Input 1 _
6- Use @ to select On, Off

and press @

When a mic capsule is connected, phantom power is set to Off for

MENU : Return

inputs 1/2.

Setting the voltage

4 =) =
Phantom —
= Use @ to select Voltage oot K
( FO r A]. '|- I n p u tS ) and Power Saving (For All Inputs) ~ Off
press @
5 =\
Voltage (For All Inputs) 1]
Use @ to select the -
- 124V
voltage, and press .
MENU : Return
HINT

When using mics and other equipment that can operate with volt-

ages less than +48V, selecting +24V can reduce power consumption

by the I B3.
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[ Changing the phantom power settings (Phantom) (continued)

Disabling phantom power during playback

=}
4 Phantom izzm)
= Use @ to select Power

On/Off >

Voltage (For All Inputs) +48V
Power Saving (For All Inputs) ~ Off

Saving (For All Inputs),

and press @

=}
5 C Power Saving (For All Tnputs) ‘&
@

Off

(Phantom off during play

back), and press @

Setting value Explanation
Off Phantom power is supplied even during playback.
On (Phantom off Phantom power is not supplied during playback.
during play back) This can reduce the a8 power consumption.

HINT
If mics do not need phantom power during playback, disabling it

can reduce IF 88 power consumption.

|This setting affects all inputs. |




[Changing the plugin power setting (Plugin Power) ]

Make this setting when a mic that is compatible with plug-in power is connected to the mic capsule’s MIC/LINE input jack.

1 Press This setting can be changed only when a mic capsule that supports
plug-in power is connected.

—x
2. Use @ to select INPUT, M I

FINDER

META DATA (for Next Take)
and press .

=)
. INPUT
3- Use @ to select Plugin

HPF

»

Input Limiter »

Phase Invert 4

Power, and press @ ool .

Plugin Power Off
Input Delay »

MENU : Return

e\
4. Use @ to select On,

and press @

MENU : Return
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[ Delaying input signals (Input Delay)

1 = Press .
—x
2. Use @ to select INPUT,

and press @

=\
3- Use @ to select Input

Delay, and press @

(Aeja@ 1nduj) sjeubis indui BuiAejag
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MENU )

FINDER
META DATA (for Next Take)

HPF 4
Input Limiter >
Phase Invert 4

4

Phantom
Plugin Power Off
Input Delay »

MENU : Return

If there are differences in the timing of input signals, use this function to correct them when recording.

=)
4- Use @ to select the input,

and press @

Input 1
Input 2
Input 3

Input 4
Input 5
Input 6

Input Delay =)

oC
00ms
0.0ms
00ms
00ms
00ms
00ms

MENU : Return

HINT

Select ALL to set all inputs at the same time.

—=x
5- Use @ to adjust the delay

time, and press .

Input 1

MENU : Return

HINT

This can be set from 0 to 30.0 ms.

|When Sample Rate is set to 192kHz, Input Delay is disabled.




[Converting mid-side input to ordinary stereo (Stereo Link Mode) ]

Signals from a mid-side stereo mic input connected to stereo-linked inputs can be converted to an ordinary stereo signal.
See "Linking inputs as a stereo pair" (— P.27) for how to use stereo linking.

Mid-side stereo format overview 1 Press

This technique creates a stereo Mid mic

recording from signals input by a —

dlrectlo.nal mid mic that captu.re.s 2_ Use @ to select INPUT, MENU =

sound in the center and a bidi- FINDER »

rectional side mic that captures @ WAL
. and press . BT} D

sounds from the left and right. ouTPUT

Mid-side recording allows you to Eiv »

change the stereo width by the MENU : Return

adjusting the level of the side

mic.

Since this technique can capture

a wide stereo image, it is ideal ,

for recording open spaces with Phase Invert >

numerous sound sources, such % %% Link Mode, and press @ E::I‘:‘;Zwer onr

as orchestras, live concerts and Input Delay »
soundscapes. ereo Link Mode

MENU : Return

Side mic

>
>

S+ | S- [Master|

Phase | Phase =) =
Q PCR . 3- Use @ to select Stereo *

Input Limiter

Ofd=

T
Y
5

+
+

Mid-side recording is also extremely effective when you want
to be able to control the amount of room ambience in a sig-
nal. For this reason, it is often used for live as well as studio
recording. In addition, the stereo signal created by this tech-
nique is fully mono-compatible, making it especially useful
when recording sound for film, video, or broadcast.
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[ Converting mid-side input to ordinary stereo (Stereo Link Mode) (continued) ]

=\
4. Use @ to select the input

Input 1/2

Input 374
pair, and press . Input 576
Input 7/8

All

Stereo Link Mode =)

BC

Stereo Link
Stereo Link
Stereo Link
Stereo Link

»

MENU : Return

HINT

Select ALL to set all input pairs at the same time.

—=x
5. Use @ to select MS Stereo

Link, and press @

Input 1/2

Stereo Link
~ MS Stereo Link

MENU : Return

Setting value

Explanation

Stereo Link

When stereo-linked, inputs are handled normally.

MS Stereo Link

When stereo-linked, signals from a mid-side mic are con-

verted to ordinary stereo.

e When MS Stereo Link is selected, odd-numbered inputs are han-
dled as mid signals and even-numbered inputs as side signals.

e The MS Stereo Link setting is disabled if a ZOOM mic capsule
is connected that cannot have L/R signals routed individually to

inputs 1/2.

HINT

e Use @ for each input to adjust the mid/side balance.
e The PFL screen allows you to adjust the side mic level for inputs

1/2 when a mid-side mic capsule is connected.




[Adjusting the input levels of multiple tracks simultaneously (Trim Link) ]

The input levels of multiple tracks can be linked and adjusted at the same time.

1 = Press .
—x
2 = Use @ to select INPUT, MENU

FINDER
and press @

META DATA (for Next Take)

MENU : Return

=)
3- Use @ to select Trim Link, Teur

Phase Invert 4
>
and press .

Phantom

Plugin Power Off
Input Delay >
Stereo Link Mode

MENU : Return

P
4. Use @ to select a track to link, and press @

Trim Link

1 2 45

3 6 7
GropA HEOOO0OO
GrowpB CJO0@EE@E OO0

crowpC 10O OO0 0O0O
GrowpD OO OOO0O0O

All Tracks: [] Clear Clear all

MENU : Return [ESISIUTRTe ]

| Linked
Not linked

HINT

You can also open the Trim Link screen from the Home Screen by

pressing (3] while pressing and holding (=].

HINT

* Youcanuse { ||} forthe first track in a link group to adjust all the
input levels within that group at the same time.

® Icons for group names are shown next to linked tracks.

BO |&ls 6 |&in//8|&B

Scene001-T001
-6 -1z -

I [ i ] “as 20 16 -1z -6 o
B way 48.000 : 1 sewso S ene001-T001 SBH: Ay 46.000  S6ndol

SD2 : MP3 320Kbos D2 : uP3 320kbos 013h53)

NOTE

® A track cannot be in more than one group at a time.

e The input levels of tracks set to MS Stereo Link will also be linked
if those tracks are put into groups.

e The input levels of tracks that have a mic capsule connected will
not be linked even if those tracks are put into groups.

(uiq wi) Ajsnoaueynwis syoedy ajdiljnw Jo sjaas| indul syl Bunsnlpy
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( Adjusting the side level of a mid-side mic capsule (Side Mic Level) )

You can adjust the side mic level (stereo width) before recording when a mid-side mic capsule is connected.

1.

2.

Press for track 1 or 2.

—=x
Use @ to select Side Mic

Level, and press @

=\
Use @ to adjust the side

mic level, and press .

Trl:PFL

Input Limiter
Fader

Pan

Phase Invert

|l |

-5 -20

Side Mic Level

MENU : Return

NOTE

e The more the side mic level is increased, the greater the stereo
width.

* When set to RAW, recording will occur without stereo encoding.
The stereo width of audio in RAW format can be adjusted after
recording by using ZOOM MS Decoder or other plug-in software.

e This can be adjusted only when a mid-side type mic capsule

isconnected.

HINT

When dual channel recording is on, the side mic level can also be

set for tracks 5/6, which correspond to tracks 1/2.

HINT

This can be set to Off, RAW or in a range from -24 to +6 dB.




[Changing the automatic mixing setting (Auto Mix) ]

When using multiple mics to capture audio during a meeting,
for example, automatically attenuating the inputs of mics that
are not in active use provides the following benefits.

¢ The likelihood of feedback is reduced.

e Background noise, including fans and crowds is suppressed
to a certain level regardless of the number of people using
mics.

e Sound quality degradation due to phase differences caused
by variations in the distances of multiple mics is reduced.

1 = Press .

P

2. Use @ to select INPUT, and M =

»
»

FINDER
META DATA (for Next Take)

press @

=\
3- Use @ to select Auto Mix,

and press @

Plugin Power
Input Delay
Stereo Link Mode

Trim Link
PFL Mode
Auto Mix »

MENU : Return|

Auto Mix

=
4. Use @ to select a track,
Input 1

Input 2
and press . Tnput 3
Input 4

Input 5
Input 6

HINT
Select ALL to set all the tracks at the same time.

—x
5- Use @ to select On, and

press @

NOTE

e The following functions and settings cannot be used with this

function.

—The sampling rate cannot be set to 192 kHz.

— The Ambisonic Mode format cannot be set to any value other
than Off.

e When the sampling rate is set to 44.1-48.048 kHz and Auto Mix is
set to On, the -8 latency will increase 2 ms.

* When monitoring sounds being recorded with a mic in real-time,
increased latency can cause interference between sound trans-
mitted through the air from the source and the delayed moni-
tored sound, possibly making accurate monitoring of the sounds

difficult.

(XIIAl 01ny) Bumas Buixiw o1jewoine ayl buibuey)
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[ Changing the automatic mixing setting (Auto Mix)

WhenTrack Knob Option is set to Fader and Auto Mix is enabled, the Home Screen will appear as follows.

04:02:4%:12 2%

Meters that show the amount
of attenuation due to Auto
Mix

EEll: WAV 48.000 003h43

Empty Folder
<Track Knob Option: Fader>



[ Setting the format of Ambisonic Mode

)

By connecting mics that can output ambisonics A-format signals to Inputs 1-4, audio can be converted to ambisonics B-format

and recorded.

1 = Press .

—x
2- Use @ to select INPUT, and

press @

=\ X ,
3. Use @ to select Ambisonic

Mode, and press @

=\
4- Use @ to select Format,

and press @

MENU {22

FINDER
META DATA (for Next Take)

Ambisonic Mode »

HPF

Input Limiter
Phase Invert
Phantom
Plugin Power

Ambisonic Mode =)

o
Format Off
Mic Position Upright

5. Use

format, and press @

to select the

)

Format

Of f

+~ FuMa

AmbiX

Ambisonics A (Stereo Monitor)
FuMa (Dual

AmbiX (Dual

8pOJA 21UOSIqUIY O 1ewlo) 8y} Buimes
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[ Changing the automatic mixing setting (Auto Mix) (continued)

FuMa

This converts the signals from Inputs 1-4 to the ambisonics
FuMa B-format, and saves them as a 4-channel polyphonic
file.

AmbiX

This converts the signals from Inputs 1-4 to the ambisonics
AmbiX B-format, and saves them as a 4-channel polyphonic
file.

Format: FuMa, AmbiX

Input Ambisonics AN
1-4 . B-format converter Track
(FuMa or AmbiX) 1-4

AN
Ambisonics Stereo
N Track
Monitor converter | m UR

Ambisonics A (Stereo Monitor)

This saves the signals from Inputs 1-4 as a 4-channel poly-
phonic file without converting them to an ambisonics B-for-
mat. The monitoring signal is converted to ambisonics B-for-
mat and then to an ordinary stereo signal.

Format: Ambisonics A (Stereo Monitor)

D

Input = Track
1-4 3 1-4

- Amhisoni [N

A : Stereo N Track
B-format converter Monitor converter LR




FuMa(Dual)

This converts the signals from Inputs 1-4 to the ambisonics
FuMa B-format, and saves them as a 4-channel polyphonic file.

AmbiX(Dual)

This converts the signals from Inputs 1-4 to the ambisonics
AmbiX B-format, and saves them as a 4-channel polyphonic file.

FuMa + AmbiX

This converts the signals from Inputs 1-4 to the ambisonics
FuMa B-format, and records them to tracks 1-4. It also con-
verts the signals from Inputs 1-4 to the ambisonics AmbiX
B-format, and records them to tracks 5-8. These can be
recorded at different input levels.

Format: FuMa (Dual), AmbiX (Dual), FuMa + AmbiX

Input Ambisonics : N
1-4 B-format converter rack
(FuMa or AmbiX) 1-4
Ambisonics D
B-format converter ’ Track
(FuMa or AmbiX) 58

Ambisonics Stereo
Monitor converter

N
N Track
L/R

FuMa + Ambisonics A

This converts the signals from Inputs 1-4 to the ambisonics
FuMa B-format, and records them to tracks 1-4. It also records
the signals from Inputs 1-4 to tracks 5-8 without converting
them to an ambisonics B-format. These can be recorded at
different input levels.

AmbiX + Ambisonics A

This converts the signals from Inputs 1-4 to the ambison-
ics AmbiX B-format, and records them to tracks 1-4. It also
records the signals from Inputs 1-4 to tracks 5-8 without
converting them to an ambisonics B-format. These can be
recorded at different input levels.

Format: FuMa + Ambisonics A, AmbiX + Ambisonics A

Input Ambisonics Trackh
14 B-format converter 14
(FuMa or AmbiX) B
N
Track
5-8

Ambisonics Stereo
Monitor converter

N
N Track
L/R

(X1l 0Iny) Bumas Buixiw d1rewolne ayl Buibuey)
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[ Changing the automatic mixing setting (Auto Mix) (continued)

* The sampling rate can only be set to 192 kHz when the format of

Ambisonic Mode is Off.

e Ambisonic files are saved as 4-channel polyphonic files, not as

mono or stereo files.

e AZOOM mic capsule can only be used when the format of Ambi-

sonic Mode is Off.

* The following parameters cannot be set for tracks using Ambi-

sonic Mode input.
— Pan
— Phase Invert
— Side Mic Level
— Input Delay
— Stereo Link
— Stereo Link Mode
— Dual Channel Rec
— Trim Link

e Files recorded when the format of Ambisonic Mode is not Off
will play back as ambisonic audio sources rather than ordinary
4-channel polyphonic files. For this reason, these tracks cannot
the panned or muted during playback.

e When the sampling rate is set to 44.1-48.048 kHz and Ambisonic
Mode is not set to Off, the = BB latency will increase 2 ms.
When monitoring sounds being recorded with a mic in real-time,
increased latency can cause interference between sound trans-
mitted through the air from the source and the delayed moni-
tored sound, possibly making accurate monitoring of the sounds
difficult.

e This cannot be used with the Auto Mix function.

HINT

e Ambisonic Mode can be set during use as an audio interface
(Multi Track).

e Even when the format of Ambisonic Mode is Off, you can press
track to monitor their input sounds. When PFL mode is
set to PFL, you can monitor sounds before they are converted
to ambisonics B-format. When PFL mode is set to SOLO, you
can monitor sounds after they are converted to ambisonics

B-format.

e The input levels of the Ambisonic Mode input tracks are linked,

f’for Input 1 (or Input 5) can be used to adjust their input

10~—="75

levels.

s0 4

e The input enabled/disabled statuses of the Ambisonic Mode
input tracks are linked, so the settings of all assigned tracks can

be switched simultaneously by pressing any of their track keys.

The following parameters that can be set on the PFL screen are
linked for input tracks using Ambisonic Mode.

— HPF

— Input Limiter

— Phantom

— Fader

— PFL Mode

— Input Source

— Input Level




When Ambisonic Mode is enabled, the Home Screen will appear as follows.

U 00030300 %2 Format name

Ambiconics B (FuMa)
y Trl:W Tr2'X TI;'S'V Ird:7

8 1
o A - | —— Track 1-4 fader

170901-Ti
-16 -1z

Pan disable

INT 29.97D

00:33°15:17 "

Track 1-4 fader

HE=

© bl JaBIa Mo B EE - | 0000
Format name

Trim

Empty Folder

<Track Knob Option: Fader>

llEm 00000801 =
'r4l FRD

o —— Ambisonics B (FuMa)
Trl:W Tr2X Tr3Y TraZ

170901-T001

-45 =20 -1&

R 1 | 1

BBl : wav 48.000

<Track Knob Option: Mixer>

(XIIAl 01ny) Bumas Buixiw o1jewoine ayl buibuey)
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[Setting the mic position used for ambisonic recording (Mic Position)

By setting the mic orientation used during ambisonic recording as an — B parameter, proper positioning can be maintained
when converting to ambisonic B format if the mic orientation is changed from upright to upside down or horizontal.

1. rpress . B. use @ to select the mic e Positon -

Upside Down
® orientation, and press . ndfire
= 2 N MENU iz3)
32 = Use @ to select INPUT, and
- FINDER
(DD' META DATA (for Next Take)
3 press @
§ Setting value Explanation
2. Upright Use this setting to record with the mic upright.
g' Upside Down | Use this setting to record with the mic upside down.
S Use this setting to record with the mic oriented
g Endfire , 9
o horizontally.
F 3w som
® = Use @ to select Ambisonic
g—_ HPF
@ Input Limiter
o
3. MOde' and press @ Phase Invert
2 Phantom
8 Plugin Power
o
=
3
Q
=
° AN Ambisonic Mode =
] . BC
g 4. Use @ to select Mic Format e
g' Mic Position Upright
=]

Position, and press @

106



Upright

Front
y ——

Endfire

—

v

Upside Down

HINT

e Using the mic upright is recommended for ambisonic recording
in order to minimize reflections from the floor and the mic itself.
* When it is difficult to use the mic in an upright orientation, you
can place it upside down or pointing forward and change the Mic

Position setting accordingly.

e If this setting and the mic position do not match, sound
positioning will not be properly re-created during conversion to

ambisonic B format.
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[ Setting signals sent to headphones (Headphone Routing)

You can set the type of signal sent to the headphone output to either prefader or postfader for each track.
You can also save 10 setting combinations (Setting 1 — Setting 10).

: Headphone Routing i
1 5- Useandto 123456 78 L RMIM281S2
= Press ' %DDDDDDDDDDDDB-&

AAAAAA-R

select the setting you want

ey AllTracks: [7] Prefader  MONO Mix:
[d Postfader  AllClear:[ ]
2 = Use @ to select OUTPUT, M to change.

FINDER

[« @ Settngl  [pp]
META DATA (for Next Take)
and press . INPUT NOTE

REC * You can also press + to open the Headphone Routing
PLAY

screen.

* You can edit and save up to 10 signal settings.

= e Settings are saved automatically.
—
3. Use @ to select Headphone, - bl .
Headphoe ¥ ; .
OZ?;)E;OOH:/OH » Continue to one of the following procedures.

and press @ gtﬁ:ﬁ t::y' Settingtherouting ......... ..., P109
Output Limiter Using mono headphone output.................... P110

MAIN OUT Routing > . . N . .
Monitoring mid-side stereo signals. ................ P110

=\ —
Headphone —
4- Use @ to select Headphone :
Alert Tone Level -20dBFS
: Volume Curve Linear
Routing, and press @ DigtlBovet




)

Setting the routing

=\
6- Use @ to select the tracks/outputs for headphone

routing and press @

Mid-side stereo Headphone Routing (]| ‘T’?tcﬁs ’gu:fd to the
itori . eft headphone
monterng R M1M25152 channel

123456781
ATATAAADANA A L.
AAAAAAANAAAAZA >R

Set tracks 1-8
to prefader
(deactivates MS)

Tracks routed to the
right headphone

i channel
All Tracks: [7] Prefader  MONO Mix:

Cycles options:
v P Postfader AllClear: [ J

e Change tracks 1-8 to
postfader (cancels others)

e Change L/R to postfader EI 3 Setting 1 E

(cancels others) [A Prefader selected

e Change M1/M2 to E Postfad | d
postfader (cancels others) Z ostfader selecte
Off

e Change S1/S2 to
postfader (cancels others)
(deactivates MS)

e Change U1-U4 to
postfader (cancel others)

Mono mix
Clear all settings

* You cannot set L/R, MAIN OUT 1/2 or SUB OUT 1/2 to prefader.

¢ When Audio Interface with Rec is set to On, USB tracks 1-4 can
be assigned.

* You cannot select the 1-8, L/R , MAIN OUT 1/2, SUB OUT 1/2 and

USB1-4 tracks at the same time. Selecting one will deselect any

other.

HINT

Press @ to cycle through the options:
Prefader — Postfader — Off.

7. Press .

(Bunnoy suoydpeasH) sauoydpeay 0} Juss s|eubis buimeg
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[Setting signals sent to headphones (Headphone Routing) (continued) j

Using mono headphone output

6 P
. Headphone Routing
= Use @ to select MONO Mix, b adte st Busiss
AAAAAAAALAAAALT =L
HAANAAAANAAAALT=R
and press .

Al Tracks: [7] Prefader  MONO Mix:

[ Postfader

] & Setting1

Al Clear: []

7. Press .

Monitoring mid-side stereo signals

Signals from a mid-side stereo mic can be converted to an
ordinary stereo signal for monitoring.

)
Headphone Routing =)
6- Use @ to select !,

12345678 L RMMSIS2
PAIAAAAAAAAAAA->L

e )
and press . v ¥

AlTracks: [7] Prefader  MONO Mix: []
[d Postfader  AllClear:[]

[ed] & Settigl  [pp]

7. Press .

NOTE

e This is disabled for stereo-linked tracks that have Stereo Link
Mode set to MS Stereo Link.

e This is only enabled for tracks that have a mid-side microphone
or mid-side mic capsule connected and the Side Mic Level set to
RAW.

e When mid-side stereo monitoring is enabled, the prefader tracks
will be routed automatically to the headphone channels, with the

odd-numbered to the left and the even-numbered to the right. In

this case, the routing cannot be changed manually.




[Outputting alerts through headphones (Alert Tone Level) ]

The volume can be adjusted for alerts output to headphones when, for example, recording starts and stops.

=
1 = Press . 5 = Use @ to adjust the Alert Tone Level

— volume, and press .
MENU
2 = Use @ to select OUTPUT,
FINDER
META DATA (for Next Take) MENU : Return
and press . INPUT

REC HINT

PLAY

e This can be set to Off or between —48 and -12 dBFS.
e When set to Off, no alerts will be output.

=\
3 QUTPUT
= Use to select Headphone, e . When alerts sound Sound type

OZ;)E,:OOH:/OH Remaining battery low | 880Hz tone 4 times every 30 seconds

and press . Output Level Recording starts 1000Hz tone 1 time
Output Delay Recording stops 880Hz tone 2 times
Qutput Limiter " " "
MAIN QOUT Routing Recording not possible | 880Hz tone 3 times

s
Headphone —
4. Use @ to select Alert Tone .
Headphone Routing »
Alert Tone Level —20dBFS
Volume Curve Linear
Level, and press @ Diita oot

(1one7 auo] ua|y) ssuoydpesy ybnouayy susje BumndinQ
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[Setting the headphone output (Volume Curve) ]

The volume curve used when adjusting the headphone volume knob can be set.

)
Volume Ct =
1. press - B. use @ to select the volume oume urve =

A Curve
curve, and press . S Curve

=)
2 MENU
= Use @ to select OUTPUT, and
FINDFR
META DATA (for Next Take)
press . INPUT
- -
REC Setting value Explanation
PLAY Linear The volume will change evenly from the minimum value to
the maximum value.
The closer the volume is to its minimum position, the
ACurve idly it will ch
— :1horelrap| K i W|I change. -
3 OUTPUT e closer the volume is to its center position, the more
S Curve e
= Use @ to select Headphone, rapidly it will change.

QOutput On/Off
and press . Output Level
Output Delay

Qutput Limiter
MAIN OUT Routing

(aain) awnjop) 1ndino auoydpeay ayi Buijes

=
4 = Use @ to select Volume eacphone
Headphone Routing
Alert Tone Level -20dBFS
Cu rv e’ a nd press @ . Volume Curve Linear
Digital Boost
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[ Boosting headphone output to alleviate interference from recorded sound (Digital Boost) ]

Boosting the headphone output alleviates the interference of sound waves traveling through the air with the headphone moni-
toring signal, enabling more accurate monitoring of the sound being recorded.

1 = Press .

=\
2 = Use @ to select OUTPUT, and

press @

P

3. Use @ to select Headphone,

and press @

—x
4. Use @ to select Digital

Boost, and press @

MENU

FINDER
META DATA (for Next Take)
INPUT

»
»
»

QUTPUT »

REC
PLAY

QUTPUT

Headphone
Qutput On/Off
Qutput Level
Qutput Delay
Qutput Limiter
MAIN OUT Routing

Headphone
Headphone Routing
Alert Tone Level
Volume Curve

Digital Boost

Ext

»
-20dBFS
Linear

=)
5- Use @ to adjust the Digital Boost

amount of boost, and press

[wew].

HINT
The amount of boost can be set from 0 to +24 dB.

In situations where the sound being recorded can be heard at the

headphone monitoring position, sound waves traveling through
the air can interfere with the sound heard from the headphones,
altering the monitored sound. The more the sound heard through
the headphones is delayed and the lower its volume, the greater
the impact of the sound waves.

Digital Boost adds a set boost volume to the adjusted headphone

volume level, reducing the impact of the sound waves that travel

through the air.
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[ Disabling outputs (Output On/Off) ]

using batteries.

1 = Press .

—=x
2. Use @ to select OUTPUT,

and press @

=\
3- Use @ to select Qutput

On/0ff, and press @

(#O/uQ 1ndinQ) sindino Buigesig
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By disabling outputs that you are not using, you can reduce power consumption and increase the length of operation time when

e
4. Use @ to select the

output, and press @

MENU

FINDER
META DATA (for Next Take)

HINT
Select ALL to set all outputs at the same time.

—x
5. Use @ to select 0ff,

and press @



[Setting the standard output level (Output Level)

The standard output level can be changed.

1.

2.

Press .

—x
Use @ to select OUTPUT,

and press @

—=x
Use @ to select Output

Level, and press @

MENU
FINDER »
»
»

META DATA (for Next Take)
INPUT

REC

PLAY

OQUTPUT

Headphone
Output On/Off

Qutput Level »

Qutput Delay
Qutput Limiter
MAIN OUT Routing

=
Qutput T m=m)
4. Use @ to set the output P e o
MAIN OUT 1/2 Normal ¢-10dBV)
SUB OUT 1/2 Normal ¢-10dBV)
type, and press . Al »

MENU : Return

HINT

Select ALL to set all outputs at the same time.

e\
MAIN OUT 1/2 =3
5- Use @ to set the standard o

Mic (-40dBVY

output level, and press @

Setting value Explanation

Normal (-10dBV) | This sets the standard level to —10 dBV.

Mic (-40dBV) This sets the standard level to -40 dBV.

(19Ae7 1Ind1nQ) |9A8| Ind1no paepuels ay) Bumes
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[Setting output levels

The MAIN OUT 1/2 and SUB OUT 1/2 levels can be changed.

1 = Open the mixer on the Home

Screen. (— P11)

—x
2 = Use @ to open the MAIN

OUT 1/2 and SUB OUT 1/2

settings screen.

00:00:00_ 54351
MAIN OUT 172] | SUB OUT

229
UT 1/2

[ on/0ff

On | On/Off

Level Normal Level  Noi

Limiter

Off Limiter
Scene001-T001

On
rmal
Off

iz
oc

AN
0000 &5, =
3- Use @ to select a fader, _ AT
On/Qff  On On/Off  On
Level Normal Level Normal
Limiter  Off k)] Limiter  Off
and press @ Scene0D1-T001
1l

=)
4. Use @ to adjust the 0

On/Off  On On/Off

output level, and press @

On

Level Normal Level Mormal
Limiter  Off Limiter  Off

HINT

e This can be set to Mute or from -48.0 to +12.0 dB.
® You can also check and adjust various output settings on
MAIN OUT and SUB OUT setting screen.

the




[ Delaying output signals (Output Delay)

By delaying audio outputs, you can correct timing differences for signals input to other devices from the 8.

1. Press .
—x
2 = Use @ to select OUTPUT,

and press @

)

3- Use to select Qutput

Delay, and press @

MENU

FINDER
META DATA (for Next Take)
INPUT

REC
PLAY

QUTPUT

Headphone
Qutput On/Off
Qutput Level

Qutput Delay
Qutput Limiter
MAIN OUT Routing

=\
4- Use @ to select the Output Delay =
MAIN OUT 2 00Frames
output, and press . SUB OUT 1 00Frames
’ SUB OUT 2 0.0Frames

All 4

MENU : Return

HINT

Select ALL to set all outputs at the same time.

—
S. use @ to adjust the delay MAIN OUT 1

in frames, and press .

MENU : Return

HINT

This can be set from 0.0 to 10.0 frames.

® The delay in milliseconds depends on the frame rate of the

selected timecode.

* When Sample Rate is set to 192kHz, Output Delay is disabled.

(Aeja@ 1ndinQ) sjeubis 1ndino BulAejaqg
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[ Output Limiter

Using a limiter on the output can protect devices connected to the output jacks.

HINT HINT
For details about the effect of the limiter, see "Input limiter". (= P.83) Select ALL to set all outputs at the same time.

1 = Press .

» Continue to one of the following procedures.

Jauwi] indinQ

Using the limiter.........ccooeiviiiiiniccec e P118

Setting the tyPe «eeevieeeee e P119

2 Y - Setting the threShold.......c.eeecureeeeeeee et P119
. Use(_)tosetectourrur, [N Setting the oRack e 120
META DATA (For Next Take) Setting the release time.........ccoccvveveciiiiiicccc, P120

and press @ INPUT SEHHNG INKS cvvvovecvecvreececteeee et e ees s s senseseeeesserans P121

REC
PLAY

Using the limiter

)
—x 5 < > MAIN OUT 1/2 )
3 Use @ to select Output QUTPUT = Use to select On/Off, T OffD(
[
Headphone @ Type Hard Knee
Output On/Off Threshold - 2dBFS
o and press .
Limiter, and press @ . Output Level P Attack Time 1ms
Output Delay Release Time 200ms

Output Limiter
MAIN OUT Routing

Link On
MENU : Return

P )
4- Use @ to Select the Qutput Limiter 6- Use @ to select On' o On/Off —

MAIN OUT 1/2

output, and press Al and press .

MENU : Return MENU : Return

118



Setting the type

=)
MAIN OUT 1/2 L
5- Use @ to select Type, B
On/Off Ooff
and preSS Threshold - 2dBFS
Attack Time 1ms

=\
6- Use @ to select the type, — e @

Release Time 200ms
Link. On

MENU : Return

Soft Knee
and press .

MENU : Return

Setting value

Explanation

Hard Knee

Only peaks that exceed the threshold are attenuated. There
is no effect below the threshold.

Soft Knee

The limiter gradually affects the output signal about 6 dB
below the threshold for a gentler effect.

Setting the threshold

This sets the level at which the limiter begins operating.

=)
5- Use @ to select Threshold, MAIN OUT 172
On/Off
Type
and press @
Attack Time

Release Time 200ms
Link On

MENU : Return

=)
6- Use @ to adjust the Threshold

setting, and press .

MENU : Return

HINT

This can be set from —16 to -2 dBFS.

Jaywi7 indinQ
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[ output Limiter (continued)

Setting the attack time

This sets the amount of time until limiting starts after the out-
put signal exceeds the threshold.

=)
5- Use @ to select Attack HANOUT 172 =
On/Off Off
Type Hard Knee
T-| me, and press @ . Threshold - 2dBFS
Attack Time 1ms

Release Time 200ms
Link On

MENU : Return

Attack Time

P
6- Use @ to adjust the time,
and press .

MENU : Return

Setting the release time

This sets the amount of time until limiting stops after the out-
put signal goes below the threshold.

e 2z
MAIN OUT 1/2
5. Use @ to select Release *

On/Off Off
Time, and press @

Type Hard Knee
Threshold - 2dBFS
Attack Time 1ms

Release Time 200ms:

Link On
MENU : Return

Release Time

—=x
6- Use @ to adjust the time,
and press .

MENU : Return

HINT

HINT

This can be set from 1 to 4 ms.

This can be set from 1 to 500 ms.




Setting links

The limiter can be linked or applied separately to MAIN OUT
1 and MAIN OUT 2, as well as to SUB OUT 1 and SUB OUT 2.

=)
5 = Use @ to select Li nk, MAIN OUT 12 -
On/Off off
Type Hard Knee
and press @ . Threshold - 2dBFS
Attack Time 1ms

Release Time 200ms
Link On

MENU : Return

—x
6- Use @ to select 0ff,

and press @

MENU : Return

Setting value Explanation
Off Separates limiter operation.
Links limiter operation. If the signal for either linked signal
On reaches the threshold, the limiter will operate on both
channels.

Jauwi] indinQ
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[ Selecting signals sent to the main outputs (VIAIN OUT Routing)

You can send either prefader or postfader signals for each track to the main outputs.

Press .

—=x
Use @ to select OUTPUT,

and press @

—x
Use @ to select MAIN OUT

Routing, and press @

MENU

FINDER
META DATA (for Next Take)
INPUT

QUTPUT »

REC
PLAY

QUTPUT

Headphone
Qutput On/Off
Output Level

Output Delay
Output Limiter

MAIN OUT Routing »

—x
Use @ to select the track for MAIN OUT 1 or MAIN

OUT 2 routing and press @

MAIN OUT Routing ]

Ext

123456781 RUIU2U3U4
PIAAAAAAAAA
AAAAAdAAAA

Converting input Al Tracks: [] Clear

track stereo signals 7] Prefader
to mid-side stereo
signals for output [ Postfader

MENU : Return

Z Select prefader
E Select postfader

[A off

Tracks routed to
MAIN OUT 1

Tracks routed to
MAIN OUT 2

Clear all settings
Set tracks 1-8 to prefader

Switches option:

* Change tracks 1-8 to
postfader

* Change L/R tracks to
postfader

e Change U1-U4 tracks
to postfader

HINT

Press @ to cycle through the options:
Prefader — Postfader — Off.

be assigned.

Selecting one type will deselect the other.

changed manually.

NOTE

e When Audio Interface with Rec is set to On, USB tracks 1-4 can

e Tracks 1-8 can be set to Prefader or Postfader.
e The L/R tracks can only be set to Postfader.
e Tracks 1-8, L/R, and USB1-4 cannot be set at the same time.

e When mid-side stereo monitoring is enabled, the pre-fader tracks
will be routed automatically to the main outputs, with odd to
the left and even to the right. In this case, the routing cannot be

5 = Press .



[ Selecting signals sent to the sub outputs (SUB OUT Routing)

You send either prefader or postfader signals for each track to the sub outputs.

Press .

—x
Use @ to select OUTPUT,

and press @

MENU

FINDER
META DATA (for Next Take)
INPUT

REC
PLAY

Converting input
track stereo signals
to mid-side stereo
signals for output

SUB OUT Routing i

Ext
123456781 RUIUSUA
AL
A

AL
A+

All Tracks: [ Clear
Prefader
[4 Postfader

Z Select prefader
E Select postfader

[A off

Tracks routed to
SUB OUT 1

Tracks routed to
SUB OUT 2

Clear all settings

Set tracks 1-8 to prefader

Switch options:

* Change tracks 1-8 to
postfader

® Change L/R tracks to
postfader

e Change U1-U4 tracks
to postfader

HINT

—x
3- Use @ to select SUB OUT cureur

Output On/OFF Press @ to cycle through the options:
Routing, and press @

Prefader — Postfader — Off.

e When Audio Interface with Rec is set to On, USB tracks 1-4 can
be assigned.

e Tracks 1-8 can be set to Prefader or Postfader.

e The L/R tracks can only be set to Postfader.

e Tracks 1-8, L/R, and USB1-4 cannot be set at the same time.
Selecting one type will deselect the other.

e When mid-side stereo monitoring is enabled, the pre-fader tracks
will be routed automatically to the sub outputs, with odd to the
left and even to the right. In this case, the routing cannot be
changed manually.

Qutput Level
Qutput Delay

Qutput Limiter
MAIN OUT Routing

SUB OUT Routing »

(Bunnnoy 1NO gNS) sindino gns ay) 01 1uss sjeubis Bunos|eg
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4. Use @ to select the track for SUB OUT 1 or SUB

OUT 2 routing and press @

5- Press . 123



MBIAIBAO BPOJBWI |

124

[ Timecode overview

The F BB can input and output SMPTE timecode.

Timecode is time information written to data when recording video and audio. It is used for video

devices, and synchronization of audio and video.

Using timecode for editing

If video and audio data both have recorded timecode, align-
ing them to a timeline and synchronizing them together is
easy when using nonlinear editing software.

HINT

The F Bl uses a precision oscillator that generates timecode with

a high degree of accuracy (+/- 0.2 ppm, or approximately 0.5 frames

per 24 hours).

editing, control of other

ecode
0:10:00:00

00:10:00:00
N

00:10:03:00

Nonlinear editing software

Audio file



Connection examples

Connections like the following are possible, depending upon
the specific equipment being used with the 8.
Synchronizing with a video camera

The IF BB records with mic input and transmits timecode.
The IF B3 saves the timecode that it generates with the
audio data. The timecode received by the video camera is
recorded with the video data.

Inputting timecode

Timecode is transmitted from an external timecode generator.
Both the I B3 and the video camera receive timecode and
record it with their audio and video data.

The input timecode can also be used to synchronize the

I~ 8 audio clock.

Timecode

>

Timecode
generator

MBIAIBAO BPOJBWI |
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[Setting timecode functions

1 = Press .

—x
2. Use @ to select TIMECODE,

and press @

3- Use @

to select Timecode,

and press @

Timecode mode
Internal timecode
Internal user bits
External timecode
External user bits

Jam button

Timecode

Mode: Int Free Run
Int TC: 00n01w21=24¢

Ubits:01 011500 FPS:30ND

Ext TC: 00n 03034529+

Ubits:00 000000 FPS:30ND

MENU :

([ Jam \

MENU

META DATA (for Next Take)
INPUT

QUTPUT

REC

PLAY

TIMECODE »
MENU : Return|

TIMECODE

Timecode
Auto Rec Delay Time
Start Timecode

Internal timecode
frame rate

External timecode
frame rate
Internal timecode
restart button

Return

» Continue to one of the following procedures.

Setting the Mode .......cccovviiiiiiiiii P127
Stopping timecode output when recording is stopped .P.128
Synchronizing audio clock with external timecode......... P129
Automatically enabling internal timecode when no

external timecode is iNPUt........cceeveveciiiiie i P129
Setting the user bits for internal timecode...................... P130
Setting the frame rate for internal timecode................... P131

Jamming internal timecode
Restarting internal timecode with a specified value ...... P132




Setting the mode

The timecode mode settings allow you to specify:

e Whether the F B3 generates timecode or receives
external timecode

e Whether or not timecode continues running when not
recording

4.

=\
Use @ to select Mode,

and press @

=\
Use @ to select Mode,

and press @

=\
Use @ to select the mode,

and press @

Timecode —

Mode: Int Free Run

Int TC: 00n20m 16512+
Ubits:01011500 FPS:30ND
Ext TC: 00n01#07<08+¢
Ubits:0000 0000 FPS:30ND

MENU : Return

bC

Mode Int Free Run

Int Auto Mute Off

MENU : Return

Mode —

Off

Int Record Run
Int RTC Run
Ext

Ext Auto Rec

MENU : Return

Setting value

Explanation

Off

No timecode will be written to the recording file.
Timecode will not be output from the TIMECODE OUT
jack.

Int Free Run

Internal timecode will be generated regardless of the
recording mode.
The internal timecode can be set manually using the
following menu items:

¢ MENU >TIMECODE >Timecode > Jam

e MENU >TIMECODE >Timecode > Restart
Timecode will always be output from the TIMECODE OUT
jack.

Int Record Run

Internal timecode will be generated only when recording.
The internal timecode can be set manually using the
following menu items:

e MENU >TIMECODE >Timecode > Jam

e MENU >TIMECODE >Timecode > Restart
When switching from another mode, or when recording
stops, the internal timecode will stop at the last value.

Int RTC Run

Internal timecode will be generated regardless of the
recording mode.
In the following situations, the internal timecode will be
synchronized (jammed) with the RTC (internal clock):

e At startup

e When Date/Time (RTC) has changed (— P.19)

* When switching to this timecode mode
Timecode will always be output from the TIMECODE OUT
jack.

Ext

The internal timecode will chase the external timecode.
You can also enable the automatic generation of internal
timecode when there is no external timecode. (— P. 129)

suopouny 8pooswi} Bumesg
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[ Setting timecode functions (continued)

Setting value

Explanation

Ext Auto Rec

The internal timecode will chase the external timecode.
You can also enable the automatic generation of internal
timecode when there is no external timecode. (= P.129)
Recording starts automatically when external timecode
input is detected. Recording stops automatically when
external timecode stops.

Stopping timecode output when recording is stopped

You can set whether or not timecode is output from the
TIMECODE OUT jack when recording is stopped.

a.

)

Use @ to select Mode,

and press @

=)
Use @ to select Int Auto

Mute, and press @

3
Use @ to select On,

and press @

Timecode —

Mode: Int Free Run

Int 0n20x 1612
Ubits:01 01 1500 FPS:30ND
Ext TC: 00601407508+
Ubits:00000000 FPS:30ND

Jan

MENU : Return

oC
Mode Int Free Run
Int Auto Mute Off

MENU : Return

Int Auto Mute =)

bC

Off

MENU : Return

e Timecode will continue to be output when recording/playback is
paused.
e This cannot be set when Mode is set to Off, Ext or Ext Auto Rec.




Synchronizing audio clock with external timecode

P

4. Use @ to select Mode,

and press @

—x
5. Use @ to select Ext Audio

Clock Sync, and press @

6- Use to select On,

and press @

)

Timecode |

e

Mode: Int Free Run

Int TC: 00s2 2¢

Ubits:01011500 FPS:30ND

Ext TC: 00n01.07-08+
Ubits:00000000 FPS:30ND

P

MENU : Return

Mode

Ext Audio Clock Sync
Ext Continuous

MENU : Return

Ext Audio Clock Sync -
Off

¥ 0On

MENU : Return

* This cannot be set when Mode is set to Off, Int Free Run, Int
Record Run or Int RTC Run.

e When there is no external timecode, the internal audio clock is

enabled to preserve continuity.

Automatically enabling internal timecode when no

external timecode is input

You can enable the automatic generation of internal timecode
to preserve continuity when there is no external timecode.

)

4. Use @ to select Mode,

and press @

=\
5- Use @ to select Ext

Continuous, and press @

)

6- Use to select On,

and press @

Timecode |

bC

Int TC: 0020 16-12¢
Ubits:01011500 FPS:30ND

Ext TC: 00n 01007508+
Ubits:00000000 FPS:30ND

Jan

MENU : Return

Ext Continuous

MENU : Return

Ext Continuous —

Of f

~ On

MENU : Return

e This cannot be set when Mode is set to Off, Int Free Run, Int

Record Run or Int RTC Run.

suopouny 8pooswi} Bumesg
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[ Setting timecode functions (continued)

Setting the user bits for internal timecode Setting value Explanation

User bits are data that you can set to be included in the time- uu uu uu uu You can set these values as you like on the Edit screen.

The month, day and year are entered automatically in that

code. Up to 8 numbers (0-9) and letters (A-F) can be included. mm dd yy uu | order using the RTC setting. You can set the "uu" value as
Recording date information, for example, can be useful when you like on the Edit screen.
editing later. The, day, month and year are entered automatically in that

dd mm yy uu order using the RTC setting. You can set the "uu" value as
you like on the Edit screen.

Setting the user bits (Ubits) mode The year, month and day are entered automatically in that
yy mm dd uu order using the RTC setting. You can set the "uu" value as

you like on the Edit screen.
P
4. use @ to select Ubits, and press @ HINT
Only "uu" items can be changed.
5 P
. lect Mode, = . . .
Use @ to select Ode mm dd yy uu Se‘l‘tlng user bits (Ublts)

>
and press @ —
4. Use @ to select Ubits, and press @

MENU : Return
3
5- Use @ to select Edit, -

suonouny apooswiy Bumesg

AN — mim dd yy uu
6. Use @ to select the mode, o 2
Uu uu uu uu and press .
and press @ . dd mm yy uu
yy mm dd uu

MENU : Return

MENU : Return
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6. Edit the value.

mm  dd vy ]

. . e F L
= Editing operations 0 0 15,0,

=~
Turn @

Move cursor or
change value:

Select parameter
to change:

MENU : Cancel
Press @
HINT

User bits can only consist of numbers from 0 to 9 and letters from
AtoF

7. When done changing the

=)
setting, use @ to select

Enter, and press @

Setting the frame rate for internal timecode

—x
4. Use @ to select FPS,

and press @

[ Enter |

MENU : Cancel

Timecode

Mode: Int Free Run
Int TC: 00401x25-18¢

Ubits:01 011500 [ERS:30ND

Ext TC: 00n03. 38523+
Ubits:E0 000000 FPS:30ND

MENU : Return

=
5. Use @ to select the frame
23976ND

24ND
rate, and press . 25D
29.97ND

2997

~ 30ND

MENU : Return

Setting value Explanation

This is the most common frame rate used with HD cameras
and other high-definition video recording. The count is 0.1%
slower than the actual time.

23.976ND

This is the standard frame rate used for recording film.This

24ND is also used with HD cameras.

This is the frame rate for PAL video. This is used for PAL

25ND
° video, which is used in Europe and other regions.

This is a frame rate used for NTSC color video and HD
cameras. The count is 0.1% slower than the actual time. This
is used for NTSC video, which is used in Japan, the United
States and other countries.

29.97ND

This is an adjusted frame rate that uses drop frames to make
NTSC match the actual time. This is used with video for
broadcast that requires the actual time frame to be matched.

29.97D

This is used to synchronize sound with film that is being
transferred to NTSC video. This is the standard frame rate
used for black-and-white television in Japan, the United
States and other countries.

30ND

This rate is used for special applications. This synchronizes
30D with film sound to be transferred to NTSC using 29.97fps
drop frame.The count is 0.1% faster than the actual time.

NOTE

Matching frame rates must be set in advance on all connected

video and audio devices.

suopouny 8pooswi} Bumesg
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[ Setting timecode functions (continued) j

Jamming internal timecode Restarting internal timecode with a specified value

Timecode input through the TIMECODE IN jack is used to set

suonouny apooswiy Bumesg
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internal timecode.

e\
4. Use @ to select Jam,

and press @

Timecode

Mode: Int Free Run
Int TC: 00n0Ln 2124+

Ubits:0101 1500 FPS:30ND

Ext TC: 00n 030345 29¢

(sam )

MENU : Return

Ubits(EO00 0000 FPS:30ND

4.

e
Use @ to select Restart,

and press @

Set the restart value.
= Editing operations

Move cursor or
change value:

Turn @

Select parameter

to change: Press @
Y
Use @ to select Restart,

and press @

Timecode

Mode: Int Free Run
Int TC: 00n01r33s24+

Ubits:01 01 1500 FPS:30ND
Ext TC: 00n03n 4629+

Ubits:EO 000000 FPS:30ND

Jam [ Restart |

MENU : Return

Restart

Int TC:
00n 00~ 125 22+

Restart Time:

C00n3 00m 00s 0D

MENU : Return

Restart
Int TC:
00n 00 » 24
Restart Time:

00n  00m 00s

\ Restart |
MENU : Return




[Setting automatic timecode recording delay (Auto Rec Delay Time) ]

If set to record automatically when external timecode is received, unnecessary recording could occur when timecode is received
for a brief amount time. In order to prevent this, you can set the amount of time until recording starts after timecode is received.

=\
1 = Press . 4_ Use @ to adjust the time, futo Rec Delay Time 1888

— and press .
2. Use @ to select TIMECODE, M

META DATA (for Next Take)

INPUT
and press . OuTPUT
REC
PLAY HINT
TIMECODE -
This can be set from 0.0 to 8.0 s.

MENU : Return

=\
TIMECODE
3- Use @ to select Auto Rec

Timecode

Auto Rec Delay Time
Delay Time, and press @ Start fimecode

(ewi] Aejag 98y 01ny) Aejep Bulpiodal apodawil dllewoine Bumes
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[ Setting timecode initialization used at startup (Start Timecode)

Since internal timecode stops when the I8 is turned off, the timecode is automatically initialized (jammed) during startup.

You can set the value that is used for jamming at that time.

Setting how timecode is initialized at startup

1 = Press .

)
4. Use @ to select Mode, and Start limecode

Mode

AN RTC Timecode Calibration
2 = Use @ to select TIMECODE, MEN press @

META DATA (for Next Take)

INPUT
and press . ouTPUT
REC

PLAY
)
. RTC Ti fe Calibrati L
5 = Use @ to set how timecode fecode Lalbration %o
N Execute RTC Timecede Calibration.
3 TIMECODE (I e ee e Are you sure?
= Use to select Sta rt Timecode Is |n|t|a||zed, and presss . (It has already been calibrated.)
Auto Rec Delay Time No
T.lmecode and press @ Start Timecode
r -

MENU : Return

Setting value

Explanation

When the (=N =] starts, the value set by Restart (— P.132)
is used to jam the internal timecode.

RestartTime
» Continue to one of the following procedures.
Setting how timecode is initialized at startupe................ P134
Correcting timecode errors after the power has been turned off
.............................................................................. P135 RTC

When the (o = | starts, its timecode is restored from the
timecode when the power was turned off and advanced by
the elapsed time using the Date/Time (RTC) setting

(— P19).

Since RTC is less precise than internal timecode, discrep-
ancies will occur.




Correcting timecode errors after the power has been

turned off

When the mode of Start Timecode is set to RTC, turning the
power off lowers the timecode precision, this function can
improve the error to the value close to 0.2 ppm when the

power has been turned off.

—x
4. Use @ to select RTC

Timecode Calibration, and

press @

)
Use @ to select
Recalibrate, and press @

=\
Use @ to select Yes, and

press @

Start Timecode iL_J

=

Mode RTC

RTC Timecode Calibration »

RTC Timecode Calibration ()

Ent

Execute RTC Timecode Calibration.
Are you sure?
(It has already been calibrated. »

Recalibrate No

MENU : Return|

RTC Timecode Calibration ‘58|

Ext

Execute RTC Timecode Calibration.
Are you sure?
( Execution Time :  2h 00m )

Yes No

MENU : Return

RTC Timecode Calibration )

7. Calibration completes.

Complete !

2:00:00 / 2:00:00

. . RTC Timecode Calibration ‘]
To cancel calibration, press

=\ Exit RTC Timecode Calibration.
, and use @ to select

Yes, and press @

Are you sure?

Calibration should be conducted once after updating the firmware.
After calibrating once, the result will be retained.

If the = B8 is moved to and used in an extremely hot or cold loca-
tion, timecode precision could change slightly when the power is
turned off. In such cases, we recommend calibrating it again.
Calibration is not possible when Audio Interface with Rec is set to On.

Calibration is only possible when StartTimecode mode is set to RTC.

Calibration is not possible when an FRC'8 is connected.
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[Slate mic and slate tone overview

When recording with the 8 you can add audio com-
ments that describe, for example, the scene being filmed or
the anticipated cuts. You can also record slate tone signals
that can be used to synchronize with video.

The IF B3 has a built-in slate mic for recording comments
and the ability to output a variable frequency tone signal.

HINT
A "slate" is a clapperboard used when recording video.

e The slate mic and slate tone cannot be used at the same time.

e The slate mic and slate tone cannot be used during audio file

playback.




[ Recording with the slate mic (Slate Mic)

You can use the built-in slate mic to record comments and to keep notes about recorded takes.

1.

2.

Press .

—x
Use @ to select SLATE,
INPUT

OUTPUT
and press . REC
PLAY

TIMECODE
SLATE »

MENU : Return

to select Slate Mic, SLATE o0

Slate Mic »

Slate Tone »
and press .

)

Use

MENU : Return

» Continue to one of the following procedures.

Setting the volume .........cccvvciiiiiiiiie e P137
Setting the routing ..... ...P138
LR T=TeTo] o [T o o [P UPPRN P139
Disabling the slate MiC......ccccvcuiviiiieniriiie e P139

Setting the volume

—x
4. Use @ to select Level,

and press @

=2
5- Use @ to adjust the level,

and press .

Slate Mic

=

Level +0dB

Routing

»

MENU : Return

HINT

This can be set from 0 to 24 dB.

(01Nl 818|S) 21w B1E|S BY) YUM BuIpIodaY
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[ Recording with the slate mic (Slate Mic) (continued)

Setting the routing

Set the destination for the slate mic signal.

=}
. : -
4. Use @ to select Routing, State Mc =
Level
and press . On/OFf on

=}
5 = Use @ to select the tracks/outputs for slate mic

signal routing and press @

All Tracks: [] Clear Clear all settings
Ld PostTader Set all to postfader

MENU : Return

E Select postfader

A off

Routing to tracks 1-8 is not possible when operating the 8

an audio interface (Stereo Mix).

HINT

Press @ to switch between Postfader and Off.

6- Press .



Recording

4. Press to start recording.

5- Push left toward the mic symbol and release.

6. To disable the slate mic, push left toward the

mic symbol again and release.
* When the slate mic is in use, other signals input to the tracks that
it is routed to are muted.
¢ The slate mic signal is always routed to the headphone L/R chan-
nels regardless of other routing settings.
e The MAIN OUT 1/2 and SUB OUT 1/2 faders do not affect the

levels of the slate mic and slate tone.

HINT

If you push and hold (5? left toward the mic symbol for two or

more seconds, the slate mic will be enabled until you release the

switch.

Disabling the slate mic

' -
You can set the slate mic so that it will not be enabled if

is accidentally pushed left toward the mic symbol.

4.

—=x
Use @ to select On/0ff,

and press @

—x
Use @ to select 0ff

(Lock), and press @

Slate Mic

Level
Routing

On/Off —

« Off (Lock)

On

(01Nl 818|S) 21w B1E|S BY) YUM BuIpIodaY
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[ Recording a slate tone (Slate Tone)

By adding a slate tone when the recording starts, aligning audio to video during editing will be easier. You can also use a slate
tone to coordinate levels with connected equipment.

Setting the volume

1 = Press .

=)
Slate T =g
4. use @ to select Level, 2 o o
=) Fregency 1000Hz
L) Ny
2 = Use @ to select SLATE, G and press . Routing
INPUT > On/Off
OUTPUT >
and press . REC 4
PLAY >
TIMECODE »

SLATE 4

MENU : Return

B
5. Use @ to adjust the level,
)

3. use @ to select Slate Slate Mc and press .

Slate Tone
Tone, and press @

(euo] e1e|S) BU0] B1e|S B Bulpioday

MENU : Return

MENU : Return HINT
This can be set from -20 to 0 dBFS.

» Continue to one of the following procedures.

Setting the volume ........cccvveiiiiiiii, P.140
Setting the freqUEeNCY .......ccocceeiiiiieiec e P141
Setting the routing ....ccccvcciee e P141
(=Yoo ] o [ oV USSP UPPPRRN P142
Disabling the slate tone ..........cccvveviiineinicececee P143

140



Setting the frequency

=)
4- Use @ to select Frequency’ Slate Tone [—

Level -20dBFS

Fregency 1000Hz

Routing »

and press @

Fregency

=\
5- Use @ to adjust the
frequency, and press .

1000Hz >

MENU : Return

HINT

This can be set from 100 to 10,000 Hz.

Setting the routing

Set the destination for the slate tone signal.

=)
4. Use @ to select Routing, Siate Tone =

Level -20dBFS
and press @

Fregency 1000Hz

Routing >

On/Off On

=
5 = Use @ to select the tracks/outputs for slate tone

signal routing and press @

All Tracks: [ | Clear
[4 Postfader

MENU : Return

Clear all settings
Set all to postfader

E Select postfader

A off

Routing to tracks 1-8 is not possible when operating the 8 s

an audio interface (Stereo Mix).

(auo] 81e|G) BUO} B1B|S B BUIpI0daY
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[ Recording a slate tone (Slate Tone) (continued)

HINT

Press @ to switch between Postfader and Off.

6. Press .

Recording

4. Press to start recording.

5- Push Q right toward the tone symbol and

release.

e When the slate tone is in use, other signals input to the tracks that
it is routed to are muted.

e The slate tone signal is always routed to the headphone L/R chan-
nels regardless of other routing settings.

e The MAIN OUT 1/2 and SUB OUT 1/2 faders do not affect the

levels of the slate mic and slate tone.

HINT

! —
If you push and hold @ right toward the tone symbol for one

or more seconds, the slate tone will be enabled until you push the

switch toward the tone symbol again.




Disabling the slate tone

You can set the slate tone so that it will not be enabled if C_O
is accidentally pushed right toward the tone symbol.

—x
4- Use @ to select On/0ff,

and press @

—x
5. Use @ to select 0f f

(Lock), and press @

Slate Tone L]

e

Level -20dBFS
Fregency 1000Hz
Routing »

On/Off On

On/Off —

v Off (Lock)

On

(auo] 81e|G) BUO} B1B|S B BUIpI0daY
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[ Exchanging data with a computer (SD Card Reader) ]

By connecting the FB+iwa computer, you can check and copy data on SD cards.

Connecting to a computer

1.

2.

Press .

—x
Use @ to select USB, =

PLAY

»

TIMECODE >

and press . SLATE >
SYSTEM >

»

SD CARD
UsB 4

MENU : Return

e\
Use @ to select SD Card

Audio Interface
FRC-8
Re d d er,a nd press @ " Audio Inter face with Rec

* The following operating systems are supported:
Windows: Windows 7 or later
Mac OS: Mac OS X (10.8 or later)

o The F BB cannot operate on USB bus power. Use the internal
batteries, the dedicated AC adapter or an external DC power sup-
ply to power it.

HINT
When the FF 88 is connected to a computer, the SD cards loaded

in slots 1 and 2 are recognized as separate SD cards.

Disconnecting

1 = Disconnect on the computer.

Windows: Select = & from the “Safely Remove Hardware
and Eject Media” icon on the bottom of the computer screen.

Mac OS: Drag and drop the = BB icon to the Trash.

Always follow correct computer disconnection procedures

before removing the USB cable.

2 = Disconnect the cable from the computer and the

B, and press .



[ Using as an audio interface (Audio Interface) ]

8 input signals can be input directly to a computer or an iOS device, and playback signals coming from a computer or an

iOS device can be output from the 8.

Connecting to a computer or an iOS device

1 = Press .
—
2- Use @ to select USB, =

PLAY

»

TIMECODE »

and press . SLATE ’
SYSTEM »

SD CARD »

»
MENU : Return

SD Card Reader

=)
Use @ to select Audio
Audio Inter face

FRC-8
I nter f ace, and press @ " Audio Inter face with Rec

=)
Aucio Interf [
4- Use @ to select the mode udio Interface 2:

Stereo Mix (Pad) »

and connected device Multi Track (PC/Mac) »

and press @

MENU : Return

Setting value Explanation
Stereo Mix This is a 2-in/2-out connection mode for Mac/Windows
(PC/Mac) and sends tracks 1-8 as a stereo mix.
Stereo Mix This is a 2-in/2-out connection mode for iOS devices
(iPad) and sends tracks 1-8 as a stereo mix.
This is an 8-in/4-out connection mode for Mac/Win-
Multi Track dows and 'sends.tracks 1.—8 as separate signals (cannot
(PC/Mac) be u§ed thh an iOS device). . .
A driver is necessary for use with Windows. Download
the driver from the ZOOM website (www.zoom.co.jp/).

5 = Use a USB cable to connect the = B3 and the

computer or iOS device.

(80BMIB1U| OIpNY) 8dBYBIUI OIpNE ue se Buisn
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[ Using as an audio interface (Audio Interface) (continued) ]

NOTE Disconnecting
e A Lightning to USB Camera Adapter is necessary to connect an
iOS device.
o The F BB cannot operate on USB bus power. Use the internal 1 = Press -
batteries, the dedicated AC adapter or an external DC power sup-
ply to power it.

o When the FF BB is used as an audio interface and the sampling 2 ~ . —
rate is set to 44.1/48 kHz, latency increases 2 ms. When latency = Use @ to select Exit, NPT N
increases while monitoring sounds being recorded with a mic QUTPUT »
in real-time, interference occurs between sound transmitted and press @ ESETF’EBACK Ofi

through the air from the source and the delayed monitored sound,
possibly making accurate monitoring of the sounds difficult.

[241) 4

MENU : Return

e
3. Use @ to select Yes, B

Exit Audio Interface Mode.

Are you sure?
and press .

No

MENU : Return

4. Disconnect the cable from the computer or iOS device

and the F B3



[ Using SD card recording and audio interface functions at the same time (Audio Interface with Rec) j

In addition to the two SD cards, a computer can also be used for recording backup.

Connecting

1 . Press . 5 = Use a USB cable to connect the I B3 and the

computer.

=\
2- Use @ to select USB, and

PLAY

TIMECODE
press . SLATE
SYSTEM

SD CARD

Uss 4

P

3. Use @ to select Audio

Interface with Rec, and press

Q.

=
4. Use @ to select On, and Audio Interface with Rec (58]

Off
press @

SD Card Reader

Audio Inter face

FRC-8

Audio Inter face with Rec Off
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[ Using SD card recording and audio interface functions at the same time (Audio Interface with Rec) (continued)j

Disconnecting

e The F B8 cannot operate on USB bus power. Use the internal

batteries, the dedicated AC adapter or an external DC power 1_ Press _
supply to power it.

e Audio Interface with Rec cannot be used with the following P
. . 2 Audio Tnterface with Rec
settings and functions. = Use to select 0ff, and ‘
- Sampling rate settings other than 44.1/48 kHz @ On
- SD Card Reader (— P144) press :

- Audio Interface (— P145)
-FRC-8(- r152)

e Adriver is necessary for use with Windows. Download the driver

from the ZOOM website (www.zoom.co.jp/).

3. Disconnect the cable from the computer and the
e When Audio Interface with Rec is set to On, the sampling rate P

cannot be changed. 8.

e When Audio Interface with Rec is set to On, files with sampling
rates that differ from the IFF 8 setting cannot be played.

e Set the input source to USB1-4 (— P. 80) or set USB1-4 to the
output routing (= P109, 122, 123) to monitor sound played back
from the computer. (— P. 80)

¢ When Audio Interface with Rec is set to On, the IF &3 latency
will increase 2 ms. When monitoring sounds being recorded
with a mic in real-time, increased latency can cause interference
between sound transmitted through the air from the source

and the delayed monitored sound, possibly making accurate

monitoring of the sounds difficult.




Audio interface block diagrams

1/2 jacks
SUB OUT
1/2 jack

MAIN OUT

HEADPHONE
jack

Output On/Off, Level _ _ Level _
| | |
_ Slate Mic/Tone _ Slate Mic/Tone _

|
_ Loop Back _ Output Limiter _ _ Alert Tone _
| |
Fader _
| |
_ Routing _
7
EIC
[ TruRFader | & &
| | | |
_ Mixer _
| | | |
_ Pan _
_ Tr1-8 Fader _
Input Delay
| | | |
MS Stereo

1 1
Phase Invert
| | | |
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[Audio interface block diagrams

Stereo Mix

Input Limiter Fom-=-=- ||||||||
— A
HPF ! s|e
! S| &
_ _ _ _ [} = | <
Trim [ o|o
S) 3
L3
1 O
;=
]
| :
— |~ ~ | oo “
5|5 515 H
o o o o H
=\ = =y = H




[Audio interface block diagrams (continued)

Multi Track

jack

1/2 jacks
SUB OUT
1/2 jack
HEADPHONE

. S il

_ OSUEO:\OQ Level __ Level
| |

Slate Mic/Tone _
| |

_

|
_ Output Limiter _ _ Alert Tone _
_

Slate Mic/Tone

| |
Fader _

| |
Routing _

Postfader
Prefader

Input Delay

| | | |
MS Stereo

| | | |
Phase Invert

| | |

Input Limiter [oiaiails G -
[} \/ |
1 1 _ — < !
HPF ' 21..12 '
! s s 1
1 1 ! j= = !
Trim =R I
- '
T 5 “
[} IO\ ]
| |

[}
! |-
i P ~ | | |
5|5 5|5 ! 1
ol o al o | 1
1) S =) = ] )

Audio interface block diagrams
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[Audio interface settings

)

The following settings can be made when using the I8 as an audio interface. See the relevant pages for details about

operation.

Setting loop back (Stereo Mix only)

This function allows the playback sound from the computer
or i0S device and the IF B3 inputs to be mixed and sent
back to the computer or iOS device (loop back).

You can use this function to add narration to music played
back from the computer and record the mix or stream it from
the computer, for example.

1 = Press .

=)
2. Use () toselect LOOP BACK, =

INPUT »
QUTPUT 4
and press @ LOOP BACK On
SLATE
EXIT
MENU : Return

to select On, LOOP BACK Z

3 = Use
Off

and press .

)

MENU : Return

Mixing inputs

You can adjust the mix balance of input signals sent to the
computer or iOS device. When using Multitrack mode, the
individual inputs will be sent. When using Stereo Mix mode,
the mixed stereo signal will be sent.

1.

USB AUDIO INTERFACE ‘]
20N ) S|

Open the mixer on the Home

Screen. (— P11) 'Y

Stereo Mix Mode
-5

~16 -1z

Adjust the parameter settings.

See "Adjusting the input signal monitoring balance" (— P.75)
for how to change settings.

sBumes soepielul olpny
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[ Using an FR(C-8 as a controller (Connect) ]

By connecting an FRC-8to the 8, you can use it to adjust trim, fader and pan settings, for example.

1. rpress . B. Use aUSB cable to connect the F B and
the FRC-8.

PLAY

>
@ TIMECODE »
SLATE »
and press . SYSTEM ¢ |
»

—x
2- Use @ to select USB, -

6. Turn the FRC-8 power ON.

When disconnecting the FRC'8 select "Disconnect" before

SD CARD
UsB »

MENU : Return

unplugging the USB cable.

=)
USB =
3. Use @ to select FRC-8,
SD Card Reader >
Audio Interface >
and press @ — , >
Audio Interface with Rec Off

4 X =
- Use @ to select Connect, -
Connect >
@ User Key »
Knob/Fader Mode Absolute
and press ) Power Source 4

Keyboard Type us

MENU : Return



[ Setting the type of keyboard connected to the FR(C-8 (Keyboard Type) ]

You can connect a PC keyboard to the FRC-8 and use it to input characters.
Set the type of PC keyboard connected to the FRC-8.

1 = Press . 4. Use @ to select Keyboard Biocommect

User Key
Typ e and press @ Knob/Fader Mode
" Power Source
Keyboard Type
LED Brightness

—x
2 = Use @ to select USB,
PLAY

@ TIMECODE
SLATE
and press . ovSTEM

SD CARD

A
5 = Use @ to select the type,

P
and press @

Keyboard Type =)

=

3. Use @ to select FRC-8,

and press @

Setting value Explanation
us Use for English-language keyboards.
JP Use for Japanese keyboards.

(8dAL pieogAsy|) 8= Y 4 a1 01 pa1osuuod pieogAsy jo adAy syi Buimes
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[Setting FRC-8 fader and knob operation (Knob/Fader Mode) ]

How the FRC-8 faders and TRIM/PAN knobs operate when their positions differ from actual parameter values can be set.

3
1 = Press -: } 5- Use @ to select the FRC-8 - ItK""b’Fade’ Mode

fader and knob operation, and

=)

o 2 = Use @ to select USB, and
& PLAY ress
g' TIMECODE P )
- press . SLATE
-0 SYSTEM
L SD CARD
:)-e USH Setting value Explanation
I3 Absolute When a knob or fader is operated, the parameter value
) will change to the value shown by that knob or fader.
% = When a knob or fader is operated, the parameter value
3 3 = Use @ to select FRC-8, and Safety will not change until the knob or fader first matches that
o ! SD Card Reader value
° .
'g @ Audio Interface
3 ress .
%- p Audio Interface with Rec Off NOTE
=}
= | The FRC'8 headphone volume operation cannot be changed. |
3
o
‘I\'I
Q
Q.
g —x
= 4
g = Use @ to select Knob/Fader
) Disconnect
= User Key

Mode and press . Knob/Fader Mode Absolute

’ Power Source »

Keyboard Type
LED Brightness
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[ Setting user keys for the FR(C-8 (User Key)

You can assign functions to the FRC-8 user keys.

1.

2.

Press .

—x
Use @ to select USB,
and press @

—x
Use @ to select FRC-8,

and press @

=)
Use @ to select User Key,

and press @

PLAY
TIMECODE
SLATE

SYSTEM
SD CARD
USB

Disconnect

User Key
Knob/Fader Mode
Power Source
Keyboard Type
LED Brightness

e

4
4
4
4
»

P|

MENU : Return

bC

4

Absolute

MENU : Return

—=x
5. Use @ to select the key to

which to assign a function,

and press @

=\
6. Use @ to select the

function to assign,

and press @

User Key i)

e

User 1 Slate Tone

User 2 Mark

User 3 Clear Clip Indicator

None
Slate Mic

+ Slate Tone

Mark
Set Trim Link
Hold

Setting value Explanation
None No function is assigned.

Slate Mic Enable and disable the slate mic.
Slate Tone Generate and stop slate tones.

Mark and playback.

Add marks to WAV format takes during recording

SetTrim Link | Open the MENU > INPUT >Trim Link screen.

Hold Use to disable the keys set with "Key Hold Target".
Clear Clip Clear the level meter clipping indicators.
Indicator

Circled Circle the currently selected take.

(Aay| 18sn) 8=y 4 21 104 sAay sasn Buimesg
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[Setting the power supply used by the FRC-8 (Power Source)

)

1 = Press .

Y
2 = Use @ to select USB,

and press @

—x
Use @ to select FRC-8,
and press @

(891n0g 1amod) 8=y 4 8y1 Aq pasn Ajddns samod sy Buimes
n
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bC

PLAY 4
TIMECODE 4
SLATE 4
4
»

SYSTEM
SD CARD

UsB > |

MENU : Return|

3
4. Use @ to select Power

Source, and press @

Set the DC power supply shutdown voltage, nominal voltage and type of batteries so that the remaining power supply charge
can be shown accurately. On this menu page, you can check the voltage of each power supply and the remaining battery capacity.

=z
oC

Disconnect

User Key

Knob/Fader Mode Absolut
Power Source

Keyboard Type

LED Brightness

Power settings for the FRC'8 are the same as for the
— BB . See "Setting the power supply used" (= P.22).

the following order of priority.
1. DC power supply (Ext DC)
2. AA batteries (Int AA)

The voltages of each power supply are shown on the display.

NOTE

When multiple power supplies are connected, they will be used in




[ Setting the FR(C-8 LED brightness (LED Brightness)

You can adjust the brightness of the LEDs on the FRC-8.

1 = Press .

2 = Use @ to select USB,

and press @

3. Use @ to select FRC-8,

and press @

4- Use @ to select LED

Brightness, and press @

PLAY
TIMECODE
SLATE
SYSTEM
SD CARD

USB >

MENU : Return

Disconnect

User Key
Knob/Fader Mode
Power Source
Reyboard Type

MENU : Return

n
5 = Use @ to adiust the LED Brightness

brightness, and press .

HINT

This can be set from 5 to 100.

(sseulyblg @37) sseuybug 371 8=J¥Y 4 oys Bumes
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[ Updating the FRC-8 firmware

You can check the FRC=8 firmware version and update it to the latest version.
The latest update file can be downloaded from the ZOOM website (www.zoom.co.jp).

1 = See "Using an FRC-8 as a controller" (—+P152), and —x
5- Use @ to select USB,
PLAY
connect the F B3 and the FRC-8. @ IvEConE
NOTE and press ' SYSTEM
Updating is not possible if the remaining battery or DC power sup- USB

ply charge is low. In this case, replace the batteries with new ones

or use a charged DC power supply.

6. Use @ to select FRC-8,

aiemuwiily 8=y 4 ay: Bunepdn

2 = Copy the update file to the root directory on an SD
and press .
card.
3- Load the SD card into the SD CARD 1 slot. » Continue to one of the following procedures.

Checking the firmware version .................... P.159
If an SD card is loaded in the SD CARD 2 slot, eject it. Updating the firmware . ............c.ooinennn..n. P159

4. Press .
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Checking the firmware version

=\ .
7. Use @ to select Firmware

Version, and press @

Disconnect

User Key

Power Source
Keyboard Type
LED Brightness
Firmware Version

System Version

Boot Version

Updating the firmware

=2
7. Use @ to select Update

Firmware, and press @

e\
8- Use @ to select Yes,

and press @

User Key
Power Source
Keyboard Type

LED Brightness
Firmware Version

Update Firmware »

Update Firmware

100->110

Are you sure?

Do not turn the power off, remove an SD card or disconnect the

USB cable during an update. Doing so could cause the FRC'8 to

become unstartable.

9- After the update completes,

turn the FRC-8 power off.

Update Main System

1.00->1.10
Complete!

Please turn of f FRC-8.

MENU : Return|

asemuwiily 8=y 4 ay: Bunepdn
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[Setting how timecode is shown (Home Timecode Display Size) ]

You can change the size of the timecode display on the Home Screen.

Home Timecode Display Size {EEH)

=
1 = Press . 4. Use @ to select the size,

and press @

Timecode Display Size,

and press @

(azIg Ae|dsig apo2awi] 8WOH) uMoys si apodawil moy Bumag
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»
REC >
PLAY >
>
»

TIMECODE
SLATE
SYSTEM >

MENU : Return

Home Timecode Display Size Small

Level Meter 4
LED Brightness 100

MENU : Return

Big
— and press @
2. Use @ to select SYSTEM, -
QUTPUT

MENU : Return

Setting value

Explanation

The timecode is small and the time counter is large.

el 0000000 & 5777, =
o 00:00:16:17 *oc
SYSTEM (| - - - -
3 = Use @ to select Home ) i The timecode is large and the time counter is small.
Date/Time (RTC) > INT 23.976HND
Power Source > Big '37'22 =
Auto Power OFF On [[ELiI: " - UUUUUU DC




[Setting level meter appearance (Level Meter)

You can set how the level meters appear on the display.

1.

2.

Press .

=\
{=m)
Use @ to select SYSTEM, o¢
QUTPUT »
REC »
and press . PLAY ’
TIMECODE »
SLATE »

SYSTEM »

MENU : Return

=\ —
SYSTEM
Use @ to select Level >

Date/Time (RTC) 4
»
Meter, and press @

Power Source
Auto Power Off On

Home Timecode Display Size Small
Level Meter »
LED Brightness 100

MENU : Return

» Continue to one of the following procedures.

Settingthetype......... ..., P161
Setting the peak holdtime . ....................... P162
Setting the level meter resolution .................. P163
Setting which track level meters are shown

ontheHomeScreen......... ... ... .. .. P163
Showing track names on level meters .............. P164
Setting the level meter reference. .................. P164

Setting the type

You can set whether the level meters use VU or Peak style.

4.

=
Use @ to select Type,

and press @

=2
Use @ to select the type,

and press @

Level Meter =)

oc
Type Peak Only
Peak Hold Time 2sec
Resolution Segment

Level Meter View >
Track Name View Off
Normal Level

MENU : Return|

Reference Level

bC

+ Peak Only

Peak + VU
VU Only

MENU : Return

(421817 |9A87) @oueleadde Ja1owW |9A8| Bumes
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[ Setting level meter appearance (Level Meter) (continued)

Setting value

Explanation

Peak Only —45 -20 -1g -12
The actual peak level of the signal (dBFS) is shown
1 IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
-30 _-20 -10 20
Peak +VU Both VU and peak level are shown simultaneously. In this
mode, the bars function as a VU meter except for the right-
most bar, which shows the peak level.
1 lIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
VU Only -30 =20 -10 20

This display style is close to human hearing.

Setting the peak hold time
=\
4. Use @ to select Peak Hold

Time, and press @

=X
5- Use @ to adjust the peak

hold time, and press @

Level Meter imzm)

Type Peak Only
Peak Hold Time 2sec
Resolution Segment
Level Meter View >
Track Name View Off

Reference Level Normal Level

MENU : Return

Peak Hold Time -

MENU : Return



Setting the level meter resolution

4.

=\
Use @ to select Level Meter [

Type Peak Only
Resolution, and press @

Peak Hold Time 2sec
Segment
Level Meter View >
Track Name View Off
Reference Level

Resolution

Normal Level

MENU : Return|

N
Resoluti 1]
Use @ to select the esolution i

Solid
resolution, and press @

MENU : Return

Setting value

Explanation

Segment

e [l
! .

-30 =20 -10 0 20
(Shown when set to VU Only)
. 1 |
Solid —-20 =20 -10 i 3 20

(Shown when set to VU Only)

Setting which track level meters are shown on the

Home Screen

You can change which tracks are shown on the Home Screen.

—x
4- Use @ to select Level

Meter View, then Viewl —

Viewd, and press @

=\
5 = Use @ to select tracks to

show, and press @

Level Meter View

MENU : Return

oc
Track 3/4
Track 5/6
Track /8
Track L/R
MAIN OUT 172

MENU : Return

HINT

will appear on the Home Screen.

Multiple tracks can be shown. Not showing any tracks is also pos-

sible. If none of the check boxes are checked, no track level meters

6- Press .

(421817 |9A87) @oueleadde Ja1owW |9A8| Bumes
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[ Setting level meter appearance (Level Meter) (continued)

Showing track names on level meters

4.

e\
Use @ to select Track Name

View, and press @

Use

)

to select On,

and press @

Level Meter L

oc
Type Peak Only
Peak Hold Time 2sec

Resolution

Segment
Level Meter View >
Track Name View Off

Reference Level Normal Level

MENU : Return

Track Name View

e

Off

Setting value

Explanation

The track names are not shown

0000000 BER

are shown on the level meters.

Off
on the level meters.
sconeo01-To01 Rz gm0
0000000 &
The track names set with the
On "Track Name" setting (— P. 48)

-a5 =20 =16

Scene001-T001

Setting the level meter reference

e
4. Use @ to select Reference

Level, and press @

=)
5- Use @ to select the

reference level setting,

and press @

Level Meter —

Type Peak Only
Peak Hold Time 2sec
Segment

Resolution
Level Meter View 4
Track Name View Off

Reference Level Normal Level

MENU : Return

Reference Level —

v Normal Level

Low Level



Setting value

Explanation

When level meter type is
Peak Only

When level meter type is
Peak +VU orVU Only

Normal Level

The center of the level
meter is -12 dBFS. Clear
monitoring of levels
higher than -12 dBFS is

possible.

The center of the level meter
is 0 VU (-20 dBFS). Clear mon-
itoring of levels higher than 0
VU (-20 dBFS) is possible.

Low Level

The center of the level
meter is -20 dBFS. Clear
monitoring of levels
lower than -20 dBFS is

possible.

The center of the level meter is
-10 VU (-30 dBFS). Clear moni-
toring of levels lower than -10
VU (-30 dBFS) is possible.

(1818 |9AET) BoURIREddE J818W |9AB| BUINES
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[Setting the LED brightness (LED Brightness) J

You can adjust the brightness of the LED level meters on the front of the 8.

=
1. Press - 4. use @ to adjust the LED Brightness

— brightness, and press .
2. Use @ to select SYSTEM, -

OUTPUT

»
REC >
and press . PLAY » |
TIMECODE »
»

SLATE

SYSTEM >

MENU : Return

HINT
This can be set from 5 to 100.

MENU : Return

— —
3- Use @ to select LED SO ¥

Date/Time (RTC) 4

Power Source 4

: Auto Power Off On

B r gh t ness ;a nd press @ * Home Timecode Display Size Small

Level Meter 4
LED Brightness 100

MENU : Return

(sseuybuig @31) sseuybq @37 ays bumesg
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[ Making display settings (LCD)

You can make settings related to the display.

1.

2.

Press .

—x
Use @ to select SYSTEN,

and press @

—x
Use @ to select LCD,

and press @

e

QuTPUT

»
REC »
PLAY »
»
»

TIMECODE
SLATE

SYSTEM »

MENU : Return

SYSTEM

Power Source »
Auto Power Off |

e

Home Timecode Display Size Small

Level Meter »

LED Brightness 100

LCD »

MENU : Return

» Continue to one of the following procedures.

Setting the display brightness.........ccccccocvvviiiiiiiiiiniens P167
Changing the display backlight setting...........cccccccevvueenes P168
Making the display easier to read under bright light.....R168

Setting the display brightness

e\
4. Use @ to select

Brightness, and press @

=
5- Use @ to adjust the
brightness, and press .

LCD

oC
Brightness 100
Power Saving ~ On (Low-Backlight)
Outdoor Mode Off

MENU : Return

Brightness

MENU : Return

HINT

This can be set from 5 to 100.

(@o7) sBumes Aejdsip Buntepy
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[ Making display settings (LCD) (continued)

Changing the display backlight setting Making the display easier to read under bright light
You can set the display backlight to dim after 30 seconds The display can be set to be easier to read in bright environ-
without use. ments including in sunlight.
P — P —
LCD )
4- Use @ to select Power b S 4- Use @ to select Qutdoor . *
rightness 100 Brightness 100
@ Power Saving On (Low-Backlight) @ Power Saving On (Low-Backlight)
~ Outdoor Mace orf
= Saving, and press . Mode, and press .
@
z
«
[=3 MENU : Return MENU : Return
!
Q
<
b P =\
= i
5 5. Use @ to select the ot Power Savig 5. Use @ to select On, o Qutdoor Mode =
2  On CourBackigh®
g setting, and press . On (Backight-Of) and press .
MENU : Return MENU : Return
Setting value Explanation
off The backlight brightness does not change even
after time passes without use.
On (Low-Backlight) The backlight dims after time without use.
On (Backlight-Off) The backlight turns off after time without use.
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You can set how marks are added when is pressed while recording or playing back a WAV format file.

1 = Press .

—x
2. Use @ to select SYSTEM,

and press @

=)

3- Use @ to select PLAY Key

Option, and press @

e

OUTPUT

»
REC »
PLAY »
TIMECODE »
SLATE »

SYSTEM »

MENU : Return

SYSTEM )|

oc
Auto Power Off On
Home Timecode Display Size Small
Level Meter »
LED Brightness 100
LCD »

PLAY Key Option »

MENU : Return

» Continue to one of the following procedures.

Setting how marks are added when recording...
Setting how marks are added when playing .................. P170

Setting how marks are added when recording

=)
. i =)
4. Use @ to select Recording, PLAY Key Option o

Playing Pause Only

and press @

e\
5- Use @ to select how

marks are added, and

press @

MENU : Return

Recording

Pause Only
Pause & Mark

+ Mark Only

MENU : Return

Setting value

Explanation

Pause Only

Pressing will pause without adding a mark.

Pause & Mark

Pressing will pause and add a mark.

Mark Only

Pressing will add a mark without pausing.

(@o7) sBumes Aejdsip Buntepy
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[Adding marks when pausing (PLAY Key Option)

Setting how marks are added when playing

P =y
4. Use @ to select Playing,

and press @

=\
5- Use @ to select how

marks are added, and

press @

PLAY Key Option ]

bC

Recording Pause Only

Playing Pause Only

MENU : Return

Playing —
+ Pause Only
Pause & Mark
Mark Only

MENU : Return

Setting value Explanation
Pause Only Pressing [_>»_] will pause without adding a mark.
Pause & Mark Pressing will pause and add a mark.
Mark Only Pressing [_>»_] will add a mark without pausing.




( Setting the keys held (Key Hold Target)

Use the hold function to prevent misoperation during recording. Press + @) to turn it on/off.

Follow these instructions to set which keys are disabled by the hold function.

1 = Press .

OUTPUT

—x
2. Use @ to select SYSTEN,

REC
PLAY
and press @ TIMECODE

SLATE

MENU : Return
—\ SYSTEM
3- Use @ to select Key Hold Lovel Meter
LED Brightness
Target, and r
get, and press . PLAY Key Option

Track Knob Option
Key Hold Target »

MENU : Return|

=\
4- Use @ to select the keys

held, and press @

Key Hold Target =)

BC

Track 1-8
PFL1-8
Track Knob 1

Track Knob 2
Track Knob 3
Track Knob 4

HINT

You can select Track 1-8, PFL 1-8, Track Knob 1-8, Slate Mic, Slate
Tone, Encoder, MENU, HP Volume, REW, STOP, FF, PLAY and REC.

5 = Press .

HINT

e Even when hold is on for "STOP" and "Track1-8", you can press
+ (8] to turn the hold function off.
e Operation using the FRC'8 and F8 Control is possible even

when the hold function is on.

(10B.e) P|OH Ao)}) P8y sAey ay1 Bumes
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[Checking SD card information (Information)

You can check the size and free space of SD cards.

1 = Press .

—x
2. Use @ to select SD CARD, e

PLAY
and press . TIMECODE
SLATE

SYSTEM

BC

4
»
>
>
»

SD CARD »

MENU : Return

3.

AN
SD CARD =)
Use @ to select o
Information 4

4
4

Performance Test

Information, and press @ Format

MENU : Return

Information
Volume label SD1:F8_SD1 Free: Free space
Size: | Size
Remain:  003h48 Remaining
recordable
SD2:F8_SD2 Free: 182GB time

Size: 1.84GB
Remain: 003h47
MENU : Return




[Testing SD card performance (Performance Test)

)

You can test whether an SD card can be used with the = B3.The QuickTest is basic, and the Full Test checks the entire SD card.

1.

2.

Press .

—x
Use @ to select SD CARD,

and press @

=\
Use @ to select

Performance Test,

and press @

—x
Use @ to select the SD

card to test, and press @

REC »
PLAY »
TIMECODE »
»
4

SLATE
SYSTEM
SD CARD »

MENU : Return

SD CARD L]

e

Information »

Performance Test »

Format »

MENU : Return

MENU : Return

» Continue to one of the following procedures.

Conducting @ quUick tesSt........cccooivrierieriiiinee e P173
Conducting a full test.......ccceceiiiiiiiiii e, P174

Conducting a quick test

5. Use @

to select Quick

Test, and press @

6- Use@

to select Yes,

and press @

The card performance test will
start. The test should take about
30 seconds.

Quick Test
Full Test

MENU : Return

Quick Test

Execute Quick Test.
Are you sure?

No

MENU : Return

(1s8] ®OUBWIOMBY) BoUBWIONMEd pied g Bunss|
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[Testing SD card performance (Performance Test) (continued)

The test completes Performance Test @

7.

Result : OK

e |

The result of the evaluation will
be shown.

MENU : Return

8. Press to stop the test.

Even if a performance test result is "OK", there is no guarantee

that writing errors will not occur. This information is just to provide

guidance.

Conducting a full test

=)
Use @ to select Full Test,

and press @

The amount of time required for
the full test will be shown.

3
Use @ to select Yes,

and press @

The test completes.

The result of the evaluation will
be shown.

If the access rate MAX reaches
100%, the card will fail (NG).

SD1

bC

Quick Test

Full Test >

MENU : Return

Full Test

Execute Full Test.
Are you sure?
(Estimated Time : Oh 14m )

Yes No

MENU : Return

Performance Test =)

Result : OK
50% 100%

Access Rate
Average: 11% Max: 11%
MENU : Return




8. Press to stop the test.

* You can press to pause and resume the test.

e Even if a performance test result is "OK", there is no guar-
antee that writing errors will not occur. This information is

just to provide guidance.

o
p—1
>
@
=i
—
(=
>
2
o
=)
(7]
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[ Formatting SD cards (Format)

SD cards must be formatted for use with the I B3.

1.

2.

Press .

—=x
Use @ to select SD CARD,

and press @

=)
Use @ to select Format,

and press @

=\
Use @ to select the card to

initialize, and press @

REC

PLAY
TIMECODE
SLATE
SYSTEM

SD CARD »

MENU : Return

SD CARD L
Information >
Performance Test >

MENU : Return

Format

MENU : Return

)
5- Use @ to select Yes,
Format SD Card.

Are you sure?
and press .

Yes No

MENU : Return

NOTE

e Before using SD cards that have just been purchased or that have
been formatted by a computer, they must be formatted by the
[ =

e Be aware that all data previously saved on an SD card will be

deleted when it is formatted.




( Checking the — B8} Shortcut List

The IF BB has a shortcut feature that allows quick access to various functions.
See the “List of shortcuts” (— P. 190) for information about the shortcut functions.

1.

2.

Press .

—x
Use @ to select SYSTEM,

and press @

—x
Use @ to select Shortcut

List, and press @

MENU [

oC
OUTPUT >
REC >
PLAY [ 4 |
TIMECODE 4
SLATE »

SYSTEM »

MENU : Return

Level Meter
LED Brightness
LCD

PLAY Key Option
Trim Knob Option Trim

Shor teut List »

MENU : Return

Shorteut List —

Display Next Take STOP (hold)
Scene Increment STOP +FF
False Take REW (hold)
User Scene Name Edit STOP +Tr1
Track Name Edit STOP +Tr2
Set Trim Link STOP +1r3

MENU : Return|
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[ Backing up and loading — &) settings (Backup/Load Settings) )

IF B8 settings can be backed up to and loaded from SD cards.

1.

2.

Press .

=
Use @ to select SYSTEM,

and press @

e\
Use @ to select

Backup/Load Settings,

and press @

—x
Use @ to select the SD

card to use for backup/

loading, and press @

TIMECODE
SLATE

SYSTEM

LCD

PLAY Key Option

Track Knob Option Fader
Key Hold Target

Shorteut List

Backup/Load Settings »

MENU : Return)

Backup/Load Settings ~ 1EEE)

c

>
>

» Continue to one of the following procedures.

Backingup ... e P178
Loading. . ... P179
Backing up

This saves a backup file to the "F8_SETTINGS" folder in the
root directory of the SD card.

)
[
5. Use @ to select Backup > 3
Backup »

Load/Delete >
and press @

6. Edit the name of the file

saved.

See "Character input screen"
(= P13) for how to input
characters.

REW/FF:¢/ >

HINT

The extension of the saved backup file is ".ZSF".




[ Backing up and loading — B settings (Backup/Load Settings) (continued)

Loading

You can load a backup file that is saved in the "F8_SETTINGS"
folder in the root directory of the SD card.

5- Use @ to select Load/

Backup
Delete, and press @

MENU : Return

)
- Load/Delete =)
6- Use to select the file to : Bate: 16/09416
F8_Settings_16091 T?“e' 101

F8_Settings 1609.. |
load, and press @

ENC (hold) : Delete MENU : Return

HINT

You can press and hold @ to delete a file. Deleting a file will

completely erase its data.

e
7. Use @ to select Yes,

Are you sure?
and press .

(sBuimag peoj/dnyoeg) sbuimes B =8 Buipeo| pue dn Buppeg
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[ Restoring default setting values (Factory Reset) ]

You can restore the factory default settings.

—x
1 = Press - 4- Use @ to select Yes, Factory Reset

Reset all settings.

= and press @ Are you sure?
2. Use @ to select SYSTEM, = _ )

ouTPUT > . .

REC » The settings will be reset and the
and press @ PLAY > power will automatically turn off.
’ TIMECODE »
>

SLATE
[Svsem ] InBut vol knob setti il not b "
nput volume kn ings will n r .
MENU : Return put volume Knob settings ot be rese

MENU : Return

=\
3 SYSTEM —
= Use to select Factory PLAY Key Optian )
Track Knob Option Fader
Key Hold Target
Re € t X nd press @ " Shorteut List

Backup/Load Settings
Factory Reset »

MENU : Return|

(10say A1010B4) Sanjea Bumas ynejep Bulioisey
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[Checking the firmware version (Firmware Version)

You can check the firmware version.

1 = Press .

=\
2 =
= Use @ to select SYSTEM, o
QUTPUT »
REC »
and press . PLAY »
TIMECODE »
SLATE »

SYSTEM »

MENU : Return

=)
3 . SYSTEM
= Use to select Firmware Track Knob Opion

Key Hold Target
. Shortcut List
Ve rsion, and press @ - Backup/Load Settings
Factory Reset

Firmware Version

Firmware Version

System Version : 100
Boot Version © 100

Subsystem Version : 100

MENU : Return

(uoIS18/ 81BMWIIL) UOISIBA B1eMWLL 8y} Buppay)
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[ Updating the firmware

The IF BB firmware can be updated to the latest versions.

The latest update file can be downloaded from the ZOOM website (www.zoom.co.jp).

1 « Install new batteries in the = B3 or connect the

dedicated AC adapter to the DC IN connector.

NOTE

Upgrading is not possible if the remaining battery power is low. In

this case, replace the batteries with new ones or use the adapter.

2 = Copy the update file to the root directory on an SD

card.

3. Load the SD card into the SD CARD 1 slot, and turn
the power on while pressing .

If an SD card is loaded in the SD CARD 2 slot, eject it first.

e
4. Use @ to select Yes Update Systems

100->1.10
and press @ Are you sure?

Do not turn the power off or remove the SD card during the update.

Doing so could cause the I~ 8 t0 become unstartable.

5 = After the update completes, Update Systems

100->1.10

turn the power off. Completel

Please power off.




[ Troubleshooting

If you think that the 8 operating incorrectly, check the following items first.

Recording/playback trouble

¢ There is no sound or output is very quiet

- Check the connections to your monitoring system and its volume
setting.

- Confirm that the volume of the IFF BBis not too low. (= P75)

¢ No sound from connected equipment or inputs or it is very quiet

- If you are using a mic capsule, confirm that it is oriented correctly.

- Check the input level settings. (= P27)

- If a CD player or other device is connected to an input jack, raise the
output level of that device.

- Check the input signal monitoring settings. (— P75)

- Check the phantom power and plug-in power settings. (= P90, R93)

- Check the headphone, MAIN OUT 1/2 and SUB OUT 1/2 routing
settings. (= P108, R122-123)

& Recording is not possible

- Confirm that track keys are lit red.

- Confirm that the SD card has free space. (= P172)

- Confirm that an SD card is loaded properly in a card slot.

- If “Card Protected!” appears on the display, the SD card write-
protection is enabled. Slide the lock switch on the SD card to disable
write-protection.

¢ The recorded sound cannot be heard or is very quiet
- Confirm that the volume levels of the tracks are not too low. (— P52)
- Confirm that track keys are lit green during playback.

Other trouble

¢ Computer does not recognize the 8 cven though it is con-

nected to the USB port

- Confirm that the operating system is compatible. (= P144)

- The operation mode must be set on the 8 10 allow the computer
to recognize the 8. - ri5)

+ Battery operation time is short

Making the following settings increase the battery operation time.

- Set the power supply used correctly. (= P22)

- Turn unnecessary tracks off. (= P27)

- Turn unnecessary outputs off. (= P114)

- Set the phantom power voltage to 24V. (= P91)

- Disable phantom power during playback. (= P92)

- Turn timecode off if not using it. (= P127)

- Reduce the LED brightness.(— P166)

- Reduce the display brightness. (= P167)

- Set the display to dim when not used for some time. (= P168)

- Reduce the sampling rate used to record files. (= P30)

- Due to their characteristics, using nickel metal hydride batteries
(especially high-capacity ones) or lithium batteries should enable longer
use than alkaline batteries.
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[ Metadata list

Metadata contained in BEXT chunks in WAV files

Tag Explanation Remarks
SPEED= Frame rate MENU >TIMECODE >Timecode > FPS
TAKE= Take number
UBITS= User bits MENU >TIMECODE >Timecode > Ubits
MENU > META DATA (for NextTake) > Scene Name Mode
SCENE= Scene name MENU > META DATA (f-or Next Take) > Ust.ar Scene Name
MENU > FINDER > Option >Meta Data Edit > Scene
MENU > FINDER > Option > Rename
. L MENU > FINDER (Recording destination folder name)
TAPE= Name of recording destination folder | e\, . FINDER > Option > Meta Data Edit > Folder (Tape) Name
CIRCLED= Circled take MENU > FINDER > Option > Meta Data Edit > Circle
TRL= Left track name
TRR= Right track name
TR1= Track 1 name
TR2= Track 2 name Track names are written as follows.
TR3= Track 3 name TRL = left track, TRR = right track
TR4= Track 4 name TR1 =track 1,TR2 =track 2...TR8 = track 8
TR5= Track 5 name During dual channel recording, tracks 1-4 are written to tracks 5-8.
TR6= Track 6 name
TR7= Track 7 name
TR8= Track 8 name
MENU > META DATA (for NextTake) > Note
NOTE= Take note MENU > FINDER > Option > Meta Data Edit > Note




Metadata contained in iXML chunks in WAV files

iXML master tag iXML sub tag Written | Read Remarks
MENU > FINDER (SD card root folder)
<PROJECT> o o MENU > FINDER > Option > Meta Data Edit > Project
Name
MENU > META DATA (for NextTake) > Scene Name Mode
MENU > META DATA (for NextTake) > User Scene Name
<SCENE> o o . .
MENU > FINDER > Option > Meta Data Edit > Scene
MENU > FINDER > Option > Rename
MENU > FINDER > Option > Meta Data Edit >Take
<TAKE> o o X
MENU > FINDER > Option > Rename
MENU > FINDER (recording destination folder name)
<TAPE> o o MENU > FINDER > Option > Meta Data Edit > Folder
(Tape) Name
<CIRCLED> o o MENU > FINDER > Option > Meta Data Edit > Circle
<WILDTRACK> x x
<FALSE START> X X
<NO GOOD> X X
<FILE_UID> o X
<UBITS> o X MENU >TIMECODE >Timecode > Ubits
MENU > META DATA (for NextTake) > Note
<NOTE> o o . X
MENU > FINDER > Option > Meta Data Edit > Note
<BEXT> X
<USER> X
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[ Metadata list (continued)

iXML master tag iXML sub tag Written | Read Remarks
<SPEED>
<SPEED> | <NOTE> o X
<SPEED> | <MASTER_SPEED> o o MENU >TIMECODE >Timecode > FPS
<SPEED> | <CURRENT_SPEED> ) x MENU >TIMECODE >Timecode > FPS
<SPEED> | <TIMECODE_RATE> ) X MENU >TIMECODE >Timecode > FPS
<SPEED> | <TIMECODE_FLAG> ) x MENU >TIMECODE >Timecode > FPS
<SPEED> | <FILE_SAMPLE_RATE> o X MENU > REC > Sample Rate
<SPEED> | <AUDIO_BIT_DEPTH> ) x MENU > REC >WAV Bit Depth
<SPEED> | <DIGITIZER_SAMPLE_RATE> o X MENU > REC > Sample Rate
<SPEED> | <TIMESTAMP_SAMPLES_SINCE_MIDNIGHT_HI> ) x
<SPEED> | <TIMESTAMP_SAMPLES_SINCE_MIDNIGHT_LO> o x
<SPEED> | <TIMESTAMP_SAMPLE_RATE> ) x MENU > REC > Sample Rate
iXML master tag iXML sub tag Written | Read Remarks
<SYNC_POINT_LIST>
<SYNC_POINT> | <SYNC_POINT_TYPE> X X
<SYNC_POINT> [ <SYNC_POINT_FUNCTION> X X
<SYNC_POINT> | <SYNC_POINT_COMMENT> X X
<SYNC_POINT> | <SYNC_POINT_LOW> X X
<SYNC_POINT> [ <SYNC_POINT_HIGH> X X
<SYNC_POINT> [ <SYNC_POINT_EVENT_DURATION> X X
iXML master tag iXML sub tag Written | Read Remarks
<HISTORY>
<HISTORY> | <ORIGINAL_FILENAME> o
<HISTORY> | <PARENT_FILENAME> X
<HISTORY> | <PARENT_UID> X




iXML master tag

iXML sub tag

Written

Read

Remarks

<FILE_SET>

<FILE_SET>

<TOTAL_FILES>

<FILE_SET>

<FAMILY_UID>

(o}

<FILE_SET>

<FAMILY_NAME>

<FILE_SET>

<FILE_SET_START_TIME_HI>

<FILE_SET>

<FILE_SET_START_TIME_LO>

<FILE_SET>

<FILE_SET_INDEX>

O | X [ X |X

X [ X | X |X [X|X

iXML master tag

iXML sub tag

Written

Read

Remarks

<TRACK_LIST>

<TRACK_LIST>

<TRACK_COUNT>

<TRACK> | <CHANNEL_INDEX> o
<TRACK> | <INTERLEAVE_INDEX> ) X
MENU > META DATA (for NextTake) >Track Name
<TRACK> | <NAME> o o MENU > FINDER > Option > Meta Data Edit >Track
Name
<TRACK> | <FUNCTION> X X
o=YESx =NO
Metadata and ID3 fields contained in MP3 files
Metadata D3 field Format
Timecode Artist Name TC=[HH:MM:SS:FF]
Scene name, take number TrackTitle SC=[scene name] TK=[take number]
Frame rate, file length (time) AlbumTitle FR=[frame rate] D=[file length (time)]
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[ List of shortcuts

Home Screen

Shortcut

Explanation

Press and hold

Show the name that will be given to the next
take recorded.
Example: Scene001-T002

)+

Advance the scene number by 1 (when the
Home Screen is open).

Press and hold [=]

Move the previously recorded take to the
FALSE TAKE folder (when the Home Screen
is open).

Press and hold (=]

The number given to the next recorded take
can be increased or decreased by one when
the Home Screen is open.

I+

Open the MENU > META DATA (for Next
Take) > User Scene Name screen.

Shortcut Explanation
Open the MENU > OUTPUT > Headphone >
r Headphone Routing screen.
Cl+@ During recording, the key does not need
to be used.
Use to disable the keys set with "Key Hold
— Target".
* During recording, the key does not need
to be used.
+k Circle the currently selected take.
rac
+ Open MENU >TIMECODE > Timecode
(Track 2) screen.

C+@

Open the MENU > META DATA (for Next
Take) > Track Name screen.

During recording, the key does not need
to be used.

C+06

Open the MENU > INPUT > Trim Link screen.
During recording, the key does not need
to be used.

CI+@

Open the MENU > META DATA (for Next
Take) > Note screen.

During recording, the key does not need
to be used.

LI+

Clear the level meter clipping indicators.
During recording, the key does not need
to be used.

CI+E

Open the L/R track fader settings screen.
During recording, the key does not need
to be used.




Mixer Screen

Shortcut

Explanation

Press and hold @

Reset the selected pan/fader to the default
value (when the Home Screen mixer is
open). If already set to its default value,
selecting a fader mutes the track.

Character input screen

Shortcut Explanation
[ Move the cursor vertically on a character
Press and turn @ input screen keyboard.
— Delete a character on the character input
* P
screen.
Move the cursor to "Enter" on the character
+

input screen keyboard.

Routing screen

Shortcut

Explanation

=)
Press and turn @

Move the cursor vertically
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[ Specifications

Recording media

Dual SD card slots support 16MB-2GB SD cards, 4GB-32GB SDHC cards and 64GB-512GB SDXC cards

INPUT 1-8 Connectors XLR/TRS combo jacks (XLR: 2 hot, TRS: TIP hot)
Input gain +10-+75dB
Input impedance 3.3kQ

XLR inputs (MIC)

Maximum input level

+14 dBu (at 0 dBFS, limiter ON)

Phantom power

+24/+48V 10mA maximum for each channel

Input gain -10 - +55 dB
TRS inputs (LINE) Input impedance 28 kQ
jé)_ Maximum input level +24 dBu (at 0 dBFS, limiter ON)
= Egiusl;/alent input —127 dBu or less (A-weighted, +75dB input gain, 150Q input)
Frequency 10 Hz - 80 kHz +0.5dB/~1dB (192kHz sampling rate)
characteristics
A/D dynamic range | 120 dB typ (-60dBFS input, A-weighted)
Crosstalk —-90 dB or less (between adjacent channels, 1kHz)
MIC IN ZOOM mic capsule input (use disables Inputs 1/2)
SLATE MIC Built-in mic for voice memos can be assigned to tracks freely
Connectors TA3 connectors, balanced output (2: hot)
Output impedance 150 Q or less
MAIN OUT 1/2 -
Reference output level —-10 dBV (normal output level), —40 dBV (mic output level), 1 kHz, 600Q load
Maximum output level +10 dBV (normal output level), -20 dBV (mic output level), 1 kHz, 600Q load
” Connector 3.5mm stereo mini unbalanced output jack
§_ SUB OUT 1/2 Output impedance 100 Q or less :
8 Reference output level -10 dBV (normal output level), —40 dBV (mic output level), 1 kHz, 10kQ load
Maximum output level +10 dBV (normal output level), -20 dBV (mic output level), 1 kHz, 10kQ load
Connector 1/4" unbalanced stereo output jack
HEADPHONE Output impedance 15 Q or less

Maximum output level

100mW + 100mW (32Q load)

D/A dynamic range

106 dB typ (-60dBFS input, A-weighted)




Recording formats

When WAV selected

Supported formats 44.1/47.952/48/48.048/88.2/96/192kHz, 16/24-bit, mono/stereo//2-10ch poly, BWF and iXML
Maximum simultaneous 10 (8 inputs + stereo mix)

recording tracks 8 (at 192kHz sampling rate)

When MP3 selected

Supported formats 128/192/320kbps, 44.1/48kHz, ID3v1 tags

Maximum simultaneous 9

recording tracks

Recording time

Using a 32GB card

30:51:00 (48kHz/24-bit stereo WAV)

7:42:00 (192kHz/24-bit stereo WAV)

Timecode

Connector BNC
Modes Off, Int Free Run, Int Record Run, Int RTC Run, Ext,
Ext Auto Rec (audio clock can be synchronized to timecode)
Frame rates 23.976ND, 24ND, 25ND, 29.97ND, 29.97D, 30ND, 30D
Precision +0.2 ppm
Supported input levels 0.2-5.0Vpp
Input impedance 4.6 kQ
Output level 3.3Vpp
Output impedance 50 Q or less

Power supplies

Batteries: 8 AA

AC adapter: AD-19 DC12V 2A (center plus)

External DC power supply: HIROSE HR10A-7R-4S 4-pin connector (1 pin: —, 4 pin: +), 9-16V

suoleolyoadg
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[ Specifications (continued)

Continuous recording time

When recording 2 channels at 48kHz/16-bit to SD1 with MAIN/SUB OUT OFF, TIME CODE OFF, LED/LCD Brightness 5, 32Q head-

phones, PHANTOM OFF

Alkaline batteries

8.5 hours or more

NiMH (2450mAh)

10 hours or more

Lithium batteries

12.5 hours or more

When recording 8 channels at 48kHz/24-bit to SD1 with MAIN/SUB OUT OFF, TIME CODE OFF, LED/LCD Brightness 5, 32Q head-

phones, PHANTOM OFF

Alkaline batteries

4.5 hours or more

NiMH (2450mAh)

6 hours or more

Lithium batteries

8.5 hours or more

When recording 8 channels at 192kHz/24-bit to SD1 with MAIN/SUB OUT ON, TIME CODE Int Free Run, LED/LCD Brightness 60,

320 headphones, PHANTOM 48V

Alkaline batteries

1 hour or more

NiMH (2450mAh)

2 hours or more

Lithium batteries

3 hours or more

Display 2.4" full-color LCD (320x240)
Mass storage operation
Class | USB 2.0 High Speed
Multi Track audio interface operation (driver required for Windows, not required for Mac)
Class USB 2.0 High Speed
Specifications 44.1/48/88.2/96kHz sampling rate, 16/24-bit bit rate, 8 in/4 out
USB Stereo Mix audio interface operation (no driver required)

Class

USB 2.0 Full Speed

Specifications

44.1/48kHz sampling rate, 16-bit bit rate, 2 in/2 out

Audio Interface with Rec: (driver required for Windows, not required for Mac)

Class

USB 2.0 High Speed

Specifications

44.1/48 kHz sampling rate, 16/24-bit bit rate, 10 in/4 out

Note: iOS device audio interface operation supported (stereo mode only)

Power consumption

12W

External dimensions

Main unit: 70 in. (W) x 5.5 in. (D) x 2.1 in. (H)

178.2 mm (W) x 140.3 mm (D) x 54.3 mm (H)

Weight (main unit only)

2.1 pounds (960 g)




For U.S.A.
FCC regulation warning

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is
no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following
measures:

® Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment to an outlet on a circuit different from that to which
the receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.

FCC CAUTION

Changes or modifications not expressly approved by the party responsible for

compliance could void the user’s authority to operate the equipment.

This transmitter must not be co-located or operated in conjunction with any
other antenna or transmitter.

&

— For EU Countries

‘ € Declaration of Conformity

For U.S.A. and CANADA

This device complies with part 15 of the FCC Rules and Industry Canada license-
exempt RSS standard(s). Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause
undesired operation.

This equipment complies with FCC/IC radiation exposure limits set forth for an

uncontrolled environment and meets the FCC radio frequency (RF) Exposure

Guidelines and RSS-102 of the IC radio frequency (RF) Exposure rules. This

equipment has very low levels of RF energy that are deemed to comply without
testing of specific absorption ratio (SAR).

A

p
For CANADA

Le présent appareil est conforme aux CNR d'Industrie Canada applicables
aux appareils radio exempts de licence. Lexploitation est autorisée aux deux
conditions suivantes : (1) I'appareil ne doit pas produire de brouillage, et (2)
|"utilisateur de |'appareil doit accepter tout brouillage radioélectriqgue subi,
méme si le brouillage est susceptible d’en compromettre le fonctionnement.

Cet équipement est conforme aux limites d'exposition aux rayonnements

énoncées pour un environnement non controlé et respecte les regles

d'exposition aux fréquences radioélectriques (RF) CNR-102 de I'IC. Cet

équipement émet une énergie RF trés faible qui est considérée conforme sans
évaluation du débit d'absorption spécifique (DAS).

.

J

Label is located at the bottom of the unit.
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